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SCOPE
This section provides information for pipe network designers and adminis-
trators on the use of the PipeIQ® software program for the FAAST system. It 
describes how to use the PipeIQ software to configure device settings, design 
pipe networks, and monitor FAAST detectors. The PipeIQ software also sup-
ports FAAST systems with trend graphs, reports, and data storage options. 

Pipe networks and device configurations can be created using the PipeIQ soft-
ware on a computer without connecting to a FAAST device. Once created, the 
device configuration can be transferred to the FAAST detector via the onboard 
Ethernet connection. Device monitoring is done either through the PipeIQ 
software over a LAN, via a web browser (refer to Web Server Access section) 
or via a Fire Alarm Control Panel.

Password protection is available to maintain a secure environment. PipeIQ 
can connect to a FAAST device in either Administrator or Read-Only mode. 
Administrator mode requires a password and is required to make configura-
tion changes to a FAAST device. Read-Only does not require a password and 
restricts the user from making configuration changes. The web server monitor-
ing system requires a password and permits read-only operations. Addition-
ally, the device user interface offers interactive buttons, which can be locked 
out with a passcode that is configured through PipeIQ. 

PipeIQ is a Windows® based application. The latest version may be down-
loaded from SystemSensor.com\FAAST.

GETTING STARTED
User Profile
Table 1 itemizes the responsibilities of the various PipeIQ users.

TABLE 1. PIPEIQ USER RESPONSIBILITIES

USER RESPONSIBILITIES

Pipe Network Designer Designing the floor plans using AutoCAD® soft-
ware and other tools.

Field Commissioning 
Engineer or Administrator

Commissioning of the system at the site loca-
tion with the pipe design and configuration of 
the system.

Facilities Manager or 
Distributor

Monitoring the area and taking the necessary ac-
tions in the event of faults and alarms.

Field Technician Resolving technical flaws at the site.

Users Monitoring of the system

PipeIQ User Interface
The PipeIQ user interface, as shown in Figure 1, includes a title bar, a menu 
bar, a tool bar, left and right panes, project tabs and a status bar. Table 2 de-
scribes the use of these objects.

TABLE 2. PIPEIQ INTERFACE DESCRIPTION

OBJECT DESCRIPTION

Title Bar The Title Bar is the standard Windows title bar. The applica-
tion can be minimized, maximized or closed.

Menu Bar Contains pull-down menus that enable various tasks, such as 
creating a new project, opening an existing project, saving a 
project, changing the view, etc.

Tool Bar Contains the buttons to create, open and save projects.

Left Pane Displays all the objects in a project structure.

Right Pane Displays the detailed information about the item selected in 
the left pane.

Project Tabs These three tabs provide Configuration, Pipe Design and 
Monitoring functions for the project.

Status Bar Displays the purpose of the selected menu, as indicated by 
the appropriate color, green for successful tasks and red for 
failed tasks.

FIGURE 1. PIPEIQ USER INTERFACE SCREEN/OPENING SCREEN

Menu Options
Tables 3 through 8 list the Menu Choices available on the various menus.

TABLE 3. FILE MENU

MENU CHOICE DESCRIPTION

New Creates a new project.

Open Opens an existing project.

Close Closes the current project.

Save Saves the current project.

Save As Saves the current project under a different project name.

Exit Closes the PipeIQ application.

TABLE 4. EDIT MENU

MENU CHOICE DESCRIPTION

Cut Content can be cut, copied, pasted, and deleted to buildings, 
floors or devices in the project. After an action has been 
completed, such as adding a floor or building, the location 
sensitive menu choices for adding a building, floor or device 
appear on the drop down menu to allow for additional ob-
jects in the project.

Copy

Paste

Delete

Add Building

Add Floor

Add FAAST 
Device

Rename Permits the highlighted project, building, floor or device to 
be renamed.
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TABLE 5. VIEW MENU

MENU CHOICE DESCRIPTION

Monitoring Changes the view of the project to the monitoring screen. 
(For object levels above the device level, the right pane 
shows the event record for the project.) The FAAST device 
must be connected via the Ethernet or PipeIQ to use the 
Monitor Screen.

Pipe Design Changes the view of the project to the pipe design screen.

Configuration Changes the view of the project to the configuration screen.

MENU CHOICE DESCRIPTION

Project Settings When active, allows selection of different  
measuring systems. Options are US Customary or 
Metric.

Archive Events Data Archives the list of events generated by the FAAST de-
vices in the project to the database file on the PC.

View Archived Events 
Data

Opens a report window showing archived events.

TABLE 6. SETTINGS MENU

TABLE 7. TOOL MENU

MENU CHOICE DESCRIPTION

Connect Device Connects PipeIQ to a FAAST detector. It is only  
active when PipeIQ is not already connected to the 
FAAST detector.

Send 
Configuration

In Configuration mode, PipeIQ sends updated configuration 
information to the connected FAAST detector. 

Get Remote 
Configuration 

In Configuration mode, PipeIQ receives updated configu-
ration information from the connected FAAST detector.

Configuration 
Reports

In Configuration mode, PipeIQ opens the PipeIQ report 
viewer and generates a configuration report.

Event Log Report In Monitoring mode, the PipeIQ report viewer is opened 
and a timeframe for viewing the event log can be se-
lected.

Create 
Configuration 

Text

In Configuration mode, it creates a text file containing 
the device configuration information.

Device 
Information

In Configuration and Monitoring modes, when the FAAST 
detector is highlighted, it opens the Device Information 
window and text information (notes) about the specific 
detector can be added.

Disconnect 
Device

Disconnects the network communication between PipeIQ 
and the connected FAAST detector. It is only active in 
Configuration mode when the PipeIQ  
application is connected to the FAAST detector.

Upgrade 
Firmware

In Monitoring mode, the PipeIQ Upgrade Firmware win-
dow opens, which allows authorized users to transfer 
new firmware to the device.

TABLE 8. HELP MENU

MENU CHOICE DESCRIPTION

 PipeIQ Help Opens the PipeIQ help file.

About PipeIQ Opens a window containing the version 
number of the PipeIQ software.

Submit Feedback Opens a link to a website where users may 
submit feedback about the software.

Starting the Application
There are no user credentials required to run the PipeIQ application. The only 
instances a password is required is to establish administrator level communi-
cation with a FAAST device, to establish web browser communication with a 
FAAST device or to unlock the buttons on the User Interface panel.

The administrator has full read/write capabilities within the application. It is 
highly recommended that the administrator password is changed when con-
figuring a FAAST detector.

To start PipeIQ, select Start > Programs > PipeIQ > PipeIQ or double-click 
on the PipeIQ icon on the desktop. The application opens and a new project 
may be created or an existing project may be monitored or modified.

Exiting the Application
To close the current project, but allow the application to continue running, 
choose File > Close.

To quit the PipeIQ software completely, select the X at the upper right corner 
of the application window, or select Exit from the File menu.

CREATING A PROJECT
Typically, a project consists of a site with buildings, floors and devices. When 
a new project is created, the Site, Building, Floor and Device objects are au-
tomatically created. These objects must be configured before designing the 
pipe network.

To create a project, start the PipeIQ application and select File > New, or se-
lect the project icon at the upper left of the main PipeIQ window, as shown in 
Figure 2. The New Project window opens, as shown in Figure 3. 

In the File Name box, type the name chosen for the project and select Save. A 
new PipeIQ project is created and displayed.

FIGURE 2. INITIAL PIPEIQ OPENING SCREEN

FIGURE 3. NEW PROJECT WINDOW

After choosing Save, the Project Settings pop-up window opens, as shown 
in Figure 4. To configure the the units of measurement, select US Customary 
System or Metric from the list. When the choice is complete, select OK to save 
it and close the window.
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SITE CONFIGURATION 
When a new project is created, the factory default settings are used to create 
all of the objects. Any number of buildings, floors, and devices can be created 
for a project. The settings can also be modified, depending on the values re-
quired to meet local codes and regulations.

Using PipeIQ, the site can be configured to install the pipe network for the 
FAAST system. Before installing the pipe network, the environment must 
be created where the pipe network is to be installed by configuring some 
general parameters, such as facility name, location and so on. After config-
uration is complete, the information is sent to the FAAST detector via the  
Ethernet connection. Default settings can be used for installer and application 
requirements.

Project Configuration
In the left pane, select the Configuration tab near the bottom of the window 
and double-click on the name of the project, located near the top of the win-
dow. For example: New Project. The project configuration screen appears in 
the right pane, as shown in Figure 5. Select the OK button at the bottom of the 
window to accept the information.

FIGURE 5. PROJECT CONFIGURATION SCREEN

Fill in the fields shown in Table 9:

TABLE 9. PROJECT CONFIGURATION FIELDS

FIELDS DESCRIPTION

Name Specify the name of the project.

Installer Specify the name of the person who is installing the system.

Pipe Type Specify the type of pipe material being used.

Address Specify the site address.

Units Verify the units of measure, either US Customary System  
or Metric.

Note: This value is selected when creating the project.

Building Configuration
A specific name can be provided for the default building or any new building 
that is created. To name the building, double-click on Building1 in the left 
pane. The Building1 screen opens in the right pane. Highlight the current 
name and type in the desired building name, then select the OK button at the 
bottom of the window to accept the new name.

To add a new building, right-click on the project icon and select Add Build-
ing. Alternatively, highlight the project name and select Add Building from 
the Edit menu at the top.

Floor Configuration
After finishing the building configuration, the floor must be configured by 
providing the necessary information. To configure the floor, double-click on 
the Floor name in the left pane. The Floor screen opens in the right pane. 
Highlight the current name and type in the appropriate floor name, then click 
the OK button at the bottom of the window to accept the new name.

Additional devices can be added to a floor, if required. To add devices to a floor, 
right-click on the floor icon and then select Add FAAST Device or highlight the 
floor name and select Add FAAST Device from the Edit menu.

Floors can also be added to a building depending on the requirements of the 
project. To add floors to a building, right-click on the building icon and select Add 
Floor or highlight the building name and select Add Floor from the Edit menu.

DEVICE CONFIGURATION
General Tab
The General tab section contains general device configuration parameters such as 
the site, date and time, the detection category, and button lock-out options.

To view the General tab, ensure the Configuration tab in the lower left cor-
ner of the window is highlighted and double-click on the device you wish to 
configure. The configuration information opens in the right pane, as shown 
in Figure 6. The General tab is displayed. Using the General tab, details such as  
the name of the facility, the location of the site, the device location, the contact 
person, the altitude and the nominal temperature of the area can be entered.

To configure the general device options, fill in the information specified in 
Table 10. 

FIGURE 6. GENERAL CONFIGURABLE PARAMETERS FOR FAAST DEVICE

Model Selection
Using the drop down menu, select the model number for the device you are 
configuring. This selection is used to customize PipeIQ for the model variant 
being programmed.

Certain intelligent models will require some configuration options be pro-
gramed through the Fire Alarm Control Panel. Refer to the panel manufac-
turer’s manual for instructions on programming a device via the Fire Alarm 
Panel. 

TABLE 10. GENERAL DEVICE OPTIONS

FIELDS DESCRIPTION

Facility Name Enter the name of the facility where the device is  
installed.

Facility Location Enter the address of the facility.

Device Location Enter the name of the location where the detector is 
installed.

Contact Person Enter the name of the person who is responsible for  
the system.

FIGURE 4. PROJECT SETTINGS POP-UP WINDOW
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Button Lock-Out
Depending on the model selected, the button lockout feature may or may not 
appear. If the button lock out option is not available, this configuration must 
be set via the Fire Alarm Control Panel. Under Button Lock-Out, select the 
following options:

•	 Test – Select the Test check box to lock the TEST button on the User 
Interface during normal operation.

•	 Reset – Select the Reset check box to lock the RESET button on the User 
Interface during the normal operation. 

•	 Isolate – Select the Isolate check box to lock the ISOLATE button on the 
User Interface during normal operation. 

•	 When the buttons are locked, a passcode can be entered at the device 
to unlock them. Refer to the Installation and Maintenance Instructions 
for Passcode Access.

Button Activation
The FAAST detector user interface buttons can be configured to be either 
locked or unlocked.  This prohibits unauthorized tampering.  To unlock the 
buttons at the user interface, a four-digit passcode is required. The passcode 
can only be changed with Administrator access. To change the passcode, se-
lect the passcode text box, delete the existing passcode and type a new pass-
code. The default passcode is 1111.

•	 Passcode – Type the four-digit code to unlock the buttons on the User Interface. 

•	 Confirm Passcode – Type the code again to verify it.

Device Date and Time
The FAAST detector contains an internal clock that is used to timestamp log 
entries.  To set the internal clock, under  Device Date and Time, specify the 
information shown in Table 11.

When configuration of parameters on the General tab is complete, select the 
Apply button followed by the save button to Save the changes.

TABLE 11 DEVICE CALENDAR DATA

FIELDS DESCRIPTION

Device Date Specify the date of configuration of the device. Select the 
down arrow  to the right of the date. This opens the calen-
dar, as shown in Figure 7. 

Device Time Specify the time of configuration of the device. The time is 
adjusted by highlighting the hour segment and clicking the 
up or down arrows   at the right of the time. This increments 
the hour display up or down. Repeat this for the minute, 
seconds and AM/PM segments.

Once the time is set, it does not keep up in real time. Time should be set 
right before sending the configuration to the device

FIGURE 8. RELAYS AND THRESHOLDS TAB FOR FAAST DEVICe

Alarm/Fault Relay Latching
The FAAST detector comes equipped with a number of relays that correspond 
to alarm and fault conditions. The latching behavior of each of the alarm con-
ditions and the minor fault condition can be configured individually.

To configure latching behavior, check the box associated with a condition. For 
non-latching operation, leave the box unchecked. Depending on the model se-
lected, the latching configuration feature may or may not appear. If the latch-
ing option is not available, this configuration must be set via the Fire Alarm 
Control Panel.

Acclimate Mode
The FAAST detector determines alarm conditions using one of two methods: 
Standard (day, night, weekend threshold) Mode or Acclimate Mode.  When 
Acclimate Mode is enabled, the detector will continually adapt to environmen-
tal conditions by automatically adjusting alarm levels within a specified range 
to reduce nuisance alarms.

To activate Acclimate Mode, select the Enable radio button. This enables 
minimum and maximum values in the Alarm Threshold and Delay section. 
The day, night and weekend settings located in the Alarm Threshold and 
Delay section are disabled. Additionally, the start and end times for the night 
mode do not apply when the FAAST detector is running in Acclimate Mode.

In Acclimate Mode, the FAAST detector automatically adjusts the alarm 
thresholds between the specified minimum and maximum sensitivities. Using 
the boundaries for each alarm level, the detector starts at the upper boundary 
of the threshold. The detector monitors the environment for the first 24 hours 
of operation and then adjusts the alarm level based on readings over the initial 
24-hour period. By allowing the system to operate in Acclimate Mode, its sus-
ceptibility to nuisance alarms is reduced. This provides maximum protection 
for an area that may have a higher than normal particulate background levels.

After the initial 24-hour period, the FAAST detector adjusts the alarm point 
based on the particulate level over a 1 hour period. The sensitivity of the 
system continues to slowly and continuously adjust over time, increasing and 
decreasing as the local environment changes.

Acclimate Mode can only be initiated through the PipeIQ software.

Night Mode
Night Mode allows separate threshold levels for day and night operation when 
Acclimate mode has been disabled. The start and end times are determined by 
the settings in this section.

To configure the Night Mode, select each segment of the time shown in the 
Start Time display and use the up and down arrows to set the segment to the 
desired time. Repeat the process for the End Time display.

If Night Mode operation is not required, set the Start Time and End Time 
fields to the same time and set the Day and Night Threshold fields to the same 
value. This disables the Night mode.

ALARM THRESHOLD and delay
Threshold Levels
There are two ways to configure the Threshold Levels:

1.	 Standard mode:

	� This mode allows you to configure the threshold levels for daytime, night-
time and weekends separately. If different night and weekend thresholds 
are not required, the night and weekend thresholds must be set to the 
same value as the day threshold.
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RELAYS AND THRESHOLDs SETTINGS
The Relays and Thresholds tab, as shown in Figure 8, provides access to alarm 
levels, Acclimate Mode, night mode, thresholds and delay times for alarm  
activation. To access these settings from the main project window, select the  
Configuration Tab in the left pane. Then in the right pane, select the Relays and 
Thresholds tab at the top of the pane. The Relays and Thresholds tab opens. 
The options displayed on the relays and thresholds tab will be customized based 
on the model selected on the General configuration tab. Refer to the Fire Alarm 
Control Panel manual for instructions on device settings that must be completed 
using the panel.



TABLE 12. DEFAULT NORMAL MODE THRESHOLD VALUES

ALARM SPECIFY THE THRESHOLD LEVEL IN %FT  
FOR NORMAL MODE

Day Night Weekend

Alert 0.012 0.012 0.012

Action 1 0.05 0.05 0.05

Action 2 0.1 0.1 0.1

Fire 1 0.25 0.25 0.25

Fire 2 0.5 0.5 0.5

2.	 Acclimate mode:

	� In this mode, the daytime, nighttime and weekend settings are not used. You 
simply configure the threshold levels for minimum and maximum values.

To configure the system in Standard mode, check Disable in the Acclimate 
Mode section located at the top center of the window. Under Threshold Lev-
els, specify the required threshold values for the system according to local 
codes and regulations or use the default values in Table 12. 

TABLE 13. ALARM THRESHOLD LEVELS

ALARM SPECIFY THE THRESHOLD LEVEL IN %FT 
FOR ACCLIMATE MODE

Minimum Maximum

Alert 0.00138 0.012

Action 1 0.0028 0.05

Action 2 0.00750 0.100

Fire 1 0.010 0.250

Fire 2 0.100 0.500

Delay
Delays are used to avoid false alarms from rapid transient conditions that are 
not actually alarm conditions. Delays are set in seconds and suspend the acti-
vation of the appropriate alarm level when the air sample reaches the thresh-
old level for that alarm. By using the delay, particulate will need to be present 
in the sensing chamber after the specified delay before an alarm is activated.

To configure the delay, under the Delay [Secs] column, specify the time in sec-
onds that the alarm activation should be delayed after the air sample reaches 
the threshold level of the alarm.

Rules Button
The Rules button displays the the restrictions for specifying Standard and Ac-
climate thresholds as shown in Figure 9. To close the Rules pop-up, select the 
red X to the right of the Rules button.
FIGURE 9. THRESHOLD RULES

FIGURE 10. NETWORK CONFIGURATION TAB

Device Details
Configure the Device Details by selecting the Identification Number. This 
arbitrary number can range from 1-255 and may be useful for record-keeping. 
The Identification Number field is also used to set the device’s SLC address. 
Refer to the Installation Manual packaged with the device for instructions on 
setting the device address.

Setting the Device Address
The ‘Identification Number’ field is also used to set the device’s SLC address. 
Refer to the Installation Manual packaged with the device for instructions on 
setting the device address.

Web Access Password
Each password is set to a default value when the FAAST device is shipped. 
The default Web Access Password is “1234”. It is highly recommended that 
the password be changed to ensure the network security of the device. Pass-
words can only be changed with Administrator access. To change the pass-
word, select the Password text box, delete the existing password and type a 
new password. The password can be up to 16 characters in length.

•	 Password -Type the password. 

•	 Confirm Password - Type the password again to verify it.

Administrator Password
Each password is set to a default value when the FAAST device is shipped. 
The default Administrator Password is “password”. It is highly recommended 
that the password be changed to ensure the network security of the device. 
Passwords can only be changed with Administrator access. To change the 
password, select the Password text box, delete the existing password and type 
a new password. The password can be up to 8 characters in length.

•	 Password -Type the password. 

•	 Confirm Password - Type the password again to verify it.

Device Mail Server Configuration
Determine the e-mail account being used for Email communications and type 
the Email address of the sender account in the Sender Account text box.

Determine the SMTP Server used for Email communications and type the 
SMTP server name into the SMTP Server Name text box.

Device Connection
In the Device Connection box, select either the DHCP or a static IP addressing option.

If a static IP address is used, type in the IP Address of the FAAST device, the 
Subnet Mask, the Default Gateway, the Primary DNS Server and the Sec-
ondary DNS Server IP Addresses if used.

Email Notification
In the Email Notification text boxes, enter the Email addresses requiring noti-
fication into the field and select the appropriate alarm checkboxes for the level 
of notification. Up to six Email addresses may be added.

When this pane is complete, select OK to accept the information and close the pane.

Connect Device
Connect Device provides a means of connecting a computer to the FAAST 
detector via the onboard Ethernet port. Once connected to the FAAST detector, 
information can be transferred between PipeIQ and the FAAST device.

To connect to the FAAST detector, select the Configuration tab, in the left 
pane, right-click on the detector and select Connect. Alternatively, select 
Tools > Connect Device from the main menu bar at the top of the window. 
Selecting the Connect Device button opens the Connection popup window, as 
shown in Figure 11. 
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To configure the system in the Acclimate mode, check Enable in the Accli-
mate Mode section, located at the top center of the window. Under Threshold 
Levels, specify the minimum and maximum threshold values for the system 
according to local codes and regulations or use the default values in Table 13.

NETWORK
The Network tab displays the network parameters for the device. Identifica-
tion numbers, passwords, Email configurations and IP addresses are all con-
figurable from this screen.

Note: for more information see the Networking Whitepaper.

From the main project window, select the Configuration tab in the left pane. 
Then in the right pane, select the Network tab at the top of the pane. The 
Network Configuration tab opens, as shown in Figure 10.



FIGURE 11. CONNECT POPUP WINDOW

Enter the IP address of the Host (FAAST detector), select either Read-Only or 
Administrator from the User list. If Administrator is selected, the Password 
text box is activated. Enter the administrator password and select the Connect 
button.

If connecting to the detector is successful, the icon for the detector changes as 
shown in Table 14.Create 

TABLE 14. DEVICE STATUS

DETECTOR STATUS DESCRIPTION

 PipeIQ application is connected to 
the detector.

 PipeIQ application is not connected 
to the detector.

Configuration Text
The PipeIQ application facilitates creation of a configuration text file for each 
FAAST device in the project. The configuration file is saved with a .txt extension.

To create the configuration file, select the Configuration tab, from the left 
pane, right-click on the FAAST device and select Create Configuration Text or 
from the main menu bar, select Tool > Create Configuration Text. A message 
appears indicating that the file has been created.

Send Configuration
Send Configuration downloads the saved configuration from the PipeIQ ap-
plication to the FAAST detector. Before downloading the configuration infor-
mation, ensure that the correct FAAST device is connected to the computer.

To download configuration information, select the Configuration tab. From the 
left pane, right-click on the FAAST device, then choose Send Configuration, or 
from the menu bar select Tool > Send Configuration. Then select OK.

Get Remote Configuration
Get Remote Configuration uploads a saved configuration from the FAAST de-
tector to the PipeIQ application. Before uploading configuration information, 
make sure that the FAAST device is connected to the computer.

To upload configuration information from the FAAST detector, select the Con-
figuration tab from the left pane, right-click on the detector and choose Get 
Remote Configuration. Alternatively, from the menu bar choose Tools > Get 
Remote Configuration.

Device Information
Additional information can be recorded using the Device Notes feature. By 
providing this information, administrators may help other users to understand 
the configuration of the FAAST system.

To edit device notes, select the Configuration tab. In the left pane, right-click on 
the detector and choose Device Information. An alternative way to access this 
window is to choose Tool > Device Information from the main menu bar. Select-
ing either item opens the Device Notes window, as shown in Figure 12. 

FIGURE 12. DEVICE NOTES WINDOW

When information is added to the system, the status icon changes, as shown 
in Table 15. The device will momentarily shut down, then reset after informa-
tion has been downloaded from PipeIQ to the FAAST device.

TABLE 15. FAAST DEVICE STATUS ICONS

SYSTEM STATUS DESCRIPTION

 Detector is connected to PipeIQ with 
additional information.

 Detector is not connected to PipeIQ 
with additional information.

Archive Events Data
Live Event information generated by the FAAST devices in a project can be 
archived to the project database file. 

To archive event data, select the Configuration tab, select a detector. From the 
menu bar at the top of the window choose Settings > Archive Events Data.

DESIGNING A PIPE LAYOUT
In order to safely deploy a FAAST system, a proper air sampling pipe network 
is needed.  The PipeIQ software complements the design process by providing 
the tools necessary not only to visualize a potential network but also model its 
performance. To begin the design process, highlight a FAAST detector in the 
left pane and select the Pipe Design tab. This opens the Pipe Design window 
in the right pane, as shown in Figure 13. 

FIGURE 13. PIPE DESIGN WINDOW

FAMILIARIZING YOURSELF WITH THE TOOLBAR
To effectively and efficiently layout a design, the designer must have knowl-
edge of the local codes and standards for the site, in addition to pipe network 
design fundamentals. Knowledge of drafting tools such as AutoCAD® software 
and DXF files is helpful when working with architectural drawings.

The following section describes the different tools used to manually design a 
pipe network. It also explains other options that help the designer speed up 
the design process. Table 16 shows the different buttons on the toolbar and an 
explanation of their usage.
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BUTTON DESCRIPTION

 Import an existing floor plan in (.dxf) format.

 Changes the view of the pipe layout to isometric. 

 Changes the view of the pipe layout to the front view of the design.

 Changes the view of the pipe layout to the top view of the design.

 Changes the view of the pipe layout to the right side view of the design.

 Used to measure and scale DXF entities

Displays optional user-configurable pipe design settings.

Used to change the pipe color

Allows user to configure the following: 

Altitude(Ft.): Enter the altitude of the detector above sea level. Note: Altitude affects air pressure. The thinner air athigher  
altitudes reduces the transportation time of smoke particulate to the detector. pressure, and temperature. 

Pressure(Pa): Enter the average pressure in Pascals of the system based on the altitude above sea level. (The pressure at sea 
level is equal to 101.325 kPa = 1 atmosphere or 29.9 in. of mercury.) The default value is the pressure at sea level. 

Temperature(°F): Enter the average temperature of the environment in which the FAAST system will operate.

 Add Detector (FAAST detector) icon. Selecting this button adds a detector to the layout.

  Used to add a vertical or horizontal pipe.

  Used to add an angle pipe, either right or left.

 Opens the Pipe Wizard tool for step-by-step instructions through the pipe network design.

 Connect Pipe.

 Activates the Pan tool. This allows for different views of the network.

 Deactivates the Pan tool.

 Zooms in on the design.

 Zooms out on the design.

 Displays the pipe design calculations.

 Zooms the pipe network in or out to fit on the screen and displays the full network on the screen.

 

 

Bill of Materials (Individual and Consolidated): Displays a report identifying the materials required to build the pipe layout  
including the devices, pipe, joints and fittings, and a schematic of the layout. 

Pipe Layout: Displays a report regarding the performance of the pipe layout. The report provides information about the site, 
such as name, location, device information, configuration settings of a pipe design, different views of the pipe design,  
transportation time, sampling pressure, and so on.

 Copies the selected FAAST detector, pipe or other component.

 Cuts the selected FAAST detector, pipe or other component.

 Pastes a previously copied FAAST detector, pipe or other component.

 Deletes the selected FAAST detector, pipe or other component.

 Deletes the entire pipe design.

TABLE 16. TOOLBAR BUTTONS

IMPORTING A FLOORPLAN
Before drawing a pipe network, the designer has the option of importing a 
floorplan to facilitate network design. PipeIQ supports importation of floor-
plans in the DXF file format.

To import a floorplan, click the Import DXF button in the pipe design toolbar.  
Navigate to the file and choose Open. 

The floorplan should now be visible in the drawing area. If not, select the Top 
View followed by Zoom Extents.
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To scale the floorplan to the proper size, activate the Measuring Tape by click-
ing the button in the toolbar. The Measuring Tape button will turn blue in-
dicating the tool is active. Find a drawing element of a known size such as a 
wall and click on it.

The Measuring Tape dialog box (Figure 14) will appear showing the length of 
the wall. If the wall is the correct length, no further scaling is needed. Choose 
OK. If the wall is not the correct length, choose Edit and type the correct wall 
length into the box. Choose OK to save the change. Click on Measuring Tape 
to deactivate the tool.



When the desired changes have been made, select the OK button to close the window.

Highlight the pipe (pipe turns from red to grey) then select and drag the pipe to 
the proper location and connect it to the FAAST detector. The pipe color changes 
from grey to green to indicate the proper connection between components.

Modifying the Pipe Information
Once the pipe information has been input, the pipe diameter and/or hole 
diameter can be modified.

To modify the pipe information, double-click on the pipe that needs changing. 
The Pipe Details window shown in Figure 15, opens for the pipe. In the Pipe 
Diameter text box, enter the new value. In the Hole Diameter text box, enter 
the new value. Select OK at the bottom of the window.

Adding Additional Pipes
To add additional pipes to the design, orient the view to any view but Iso, 
then highlight the section the pipe will be connected to. The receiving section 
will turn yellow. Select and drag the pipe to the proper location and connect 
it to the existing pipe. The new pipe color changes from yellow to green to 
indicate the proper connection between components.

Auto Connect Pipes
Pipes can be automatically connected together by selecting two pipes and 
clicking the ‘Connect Pipes’ button on the tool bar.

To select two pipes, click the first pipe then hold the CTRL button on the key-
board and select the second pipe. Both  pipes will show the color of a selected 
entity (default color is grey). When the ‘Connect Pipes’ button is clicked the 
selected pipes will automatically join.

Note: The pipe will automatically connect based on the “top to bottom” or 
“left to right” orientation that was selected in the pipe details window.
TESTING THE PIPE DESIGN
After creating a pipe design, test it to ensure that the design meets the speci-
fied criteria, such as transportation time, pressure, and flow. The values can 
be corrected by auto balancing them. This may be done by selecting the Auto 
Balance button on the toolbar.

Pipe Design Calculation
To calculate the expected performance of the pipe design, select the calculator 
symbol. The Calculated Results window, as shown in Figure 16 opens.

If the calculated result for the Transport Time, Pressure, or flow will show red 
for any value less than 25 l/min. This may be corrected by manually adjusting 
the sampling hole sizes or using the Auto Balance feature. The calculated Hole 
Sensitivity is based on the Fire 1 daytime threshold and the expected dilution 
from other sampling holes. To improve the effective sensitivity, reduce the num-
ber of holes or decrease the Fire 1 threshold.

ADDING A DETECTOR
To add a FAAST detector to the design, select the drawing area, then select the 
Detector (FAAST detector) button on the toolbar in the right pane. A FAAST de-
tector must be the first item added to a pipe network design.

ADDING A PIPE
TIP: Before adding a pipe to the system, always highlight the FAAST detector 
or pipe that will be connected to the pipe section. This keeps the components 
in the same plane of the design field.

Next select the pipe orientation icon (horizontal or vertical ) from the toolbar 
that is desired to connect to the detector. The orientation of the pipe is rela-
tive to the view that you have selected. Adding a vertical pipe from the top 
view will add a pipe that runs vertically as you are looking at the screen, not 
vertically as it appears to the detector. The Pipe Details window will open as 
shown in Figure 15. Complete the fields outlined in Table 17. It is important 
to specify the direction the pipe will be extending. For example, If a vertical 
pipe is chosen for connection to an existing horizontal in order to run towards 
the top of the screen, “bottom to top” should be selected. As with adding a 
pipe, “bottom to top” or “left to right” are relative to the view you are using 
in the drawing area. 

FIGURE 16. CALCULATED RESULTS WINDOW
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FIELDS DESCRIPTION

Total Length Specify the total length of the pipe.

Pipe Diameter Specify the diameter of the pipe.

Bottom to Top Select the bottom as the starting point for a 
vertical pipe.

Top to Bottom Select the top as the starting point for a vertical pipe.

Left to Right Select the left side as the starting point for a 
horizontal pipe.

Right to Left Select the right side as the starting point for a 
horizontal pipe.

Add End Cap Check the box if an end cap is required.

Distance of Starting Hole Specify the distance of the hole from the front end.

Hole Diameter Select the diameter of the holes.

Insert Hole Use to manually insert a hole in the pipe segment.

Delete Hole Use to manually remove a hole from the pipe segment.

Distance Between Holes Specify the distance between holes.

Calculate and Place Holes Automatically adds holes to the segment  
using the specified settings.

Pipe without Holes Use to create a pipe with no sample holes.

TABLE 17. PIPE DETAILS DESCRIPTION OF FIELDS

FIGURE 15. PIPE DETAILS WINDOW
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Select the Calculate and Place Holes button to automatically place the holes 
in the pipe. Additonal information about the length of pipe can be modified 
as indicated in Table 18. To add or delete a hole from the original design, 
check the corresponding row of the hole in the Pipe Details window and 
select the Insert Hole or Delete Hole button. To create a pipe without any 
holes, select the Pipe without Holes button on the right side of the window.  
The pipe will automatically be created to the specified length, the window will 
close and return to the pipe design screen.

To make manual modifications to the hole spacing or size, select the check 
box in the left column and modify the hole diameter or relative distance be-
tween holes for the selected hole.

TABLE 18. PIPE HOLE DETAILS
FIELDS DESCRIPTION

Hole Diameter Select the diameter of the hole from the pull-down menu 
by selecting the down arrow to the right of the field.

Relative Distance Specify the relative distance of the hole from 
other holes.

Capillary Select the check box to use a capillary tube at the 
location where a hole is created.

Capillary Length Specify the length of the capillary. 

Capillary Diameter Specify the interior diameter of the capillary. 

FIGURE 14. measuring tape WINDOW
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Pipe Layout Report
The Pipe Layout Report generates a report about the site, including informa-
tion, such as name, location detector information, configuration settings of 
the pipe design, different views of the pipe network, transportation times, 
sampling pressure, etc. A sample report is shown in Figure 18.

To generate a Pipe Layout Report, select the Pipe Design tab, and double-click 
on a FAAST device to open the pipe design window. Select the Pipe Layout 
button from the toolbar. The PipeIQ Report Viewer window opens.

FIGURE 19. PIPE WIZARD INITIAL SCREEN

USING THE PIPE WIZARD
The easiest way to design a pipe network is by using the Pipe Wizard feature 
of the PipeIQ software. The wizard walks through the design of a pipe network 
in accordance with the preset application standards.

To use the Pipe Wizard, the Top view must be selected. Choose the location 
on the layout where the FAAST detector is to be located by clicking in the right 
pane. Start the Pipe Wizard by selecting the Pipe Wizard button on the Pipe 
Design toolbar. The Pipe Wizard window opens, as shown in Figure 19.

FIGURE 20. PIPE WIZARD ROOM SCREEN
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The PipeIQ software includes three preset application standards as follows:

•	 Very Early Warning Fire Detection: The VEWFD setting will generate a 
warning within PipeIQ for any transport times that are calculated to be 
greater than the required 60s.

•	 Early Warning Fire Detection: The EWFD setting will generate a warning 
within PipeIQ for any transport times that are calculated to be greater 
than the required 90s. 

•	 SFD: The SFD setting will generate a warning within PipeIQ for any 
transport times that are calculated to be greater than the required 120s.

Verify that the Installation Classification shown in the window is correct. To 
change a class of detection select the appropriate radio button. The pipe Wiz-
ard facilitates designs to accommodate both UL/ULC and EN54-20 constraints.

PipeIQ also allows for transport times to be come more strict (shorter period 
of transport) for any level of protection. Transport times may not be increased 
past the maximum level for any given level of protection. 

If the Non-EWFD Install Type is selected, the area per sample hole field is enabled 
and the value may be changed depending on local codes and regulations.

When all settings are correct, select the Next button to move to the next page 
of the wizard, the Room Screen, as shown in Figure 20.
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REPORTS
Once the pipe design is complete, Bill of Material, consolidated Bill of Materials 
and Pipe Layout Reports can be generated using the report button on the tool bar.

Bill of Material Report
The Bill of Material report provides information regarding a particular site. It 
gives detailed information regarding the materials to be used, the pipes, seg-
ment details (i.e., joints and fittings) and a schematic layout of the design.

To create a bill of material for the specific site, select the Pipe Design tab, fol-
lowed by create the pipe layout, and select the Bill of Material button on the 
toolbar. The PipeIQ Report Viewer opens allowing the report to be viewed. A 
sample report is shown in Figure 17.

FIGURE 18. PIPE LAYOUT REPORT EXAMPLE
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FIGURE 17. BILL OF MATERIAL REPORT EXAMPLE
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This screen prompts for the length, width and height of the area being pro-
tected. If the area is wide enough to require two or more branches, the Pipe 
Type section of the window is activated and one of the branch types available is 
automatically selected. Select the radio button for the type of network desired.



FIGURE 24. PIPE WIZARD DETECTOR LOCATION SCREEN
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FIGURE 25. PIPE WIZARD DEtails SCREEN

The Pipe Screen prompts for the type of pipe material being used, the pipe 
diameter, and the sample hole size.

To select the pipe material being used, select the down arrow to the right of 
the Pipe material field and select the appropriate material.

The available options for pipe materials are:

•	 CPVC	 •  PVC

•	 UPVC	 •  ABS

•	 PE		  •  Other

ASP55-01
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CAUTION: When detectors are located outside the protected area, the air flow 
should be exhausted back into the protected area, if possible, to avoid issues 
with pressure differentials between the locations.

To enter the distance from the floor where the detector will be installed, high-
light the default value and type in the desired value.

When all settings are correct, select the Next button to move to the next page 
of the wizard, the Details Screen, as shown in Figure 25.

The Details Screen provides a listing of all the parameters created for the pipe 
network design as shown in Figure 25. Review the information carefully and 
press Finish to complete the wizard. The pipe network details are displayed in 
the right pane of the PipeIQ screen.

FIGURE 22. PIPE WIZARD PIPE NETWORK SCREEN WITH CAPILLARY TUBES

The Pipe Network Screen prompts for the location of the pipe network within 
the protected area. To change the location of the network, select the down ar-
row to the right of the Pipe Location field and select the appropriate location 
(Below Ceiling, Above Ceiling or Below Floor). Next enter the distance below 
or above the ceiling or floor where the pipe network will be installed by high-
lighting the default value and typing the desired value.

If the pipe network is located above the ceiling, the screen shown in Figure 22 
opens. This is where the use of capillary tubes and the diameter of the tubes 
can be specified.

ASP-52

FIGURE 23. PIPE WIZARD PIPE PROPERTIES SCREEN
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Next determine the Pipe Network Direction and select the appropriate radio 
button (Left to Right, Top to Bottom, Right to Left or Bottom to Top).

When all settings are correct, select the Next button to move to the next page 
of the wizard, the Pipe Screen, as shown in Figure 23.

MONITORING THE DEVICES
Using the PipeIQ software, users and administrators can monitor networked 
FAAST detectors. A FAAST detector may be monitored either using the PipeIQ 
software or an Ethernet connection and a web browser (see the Web Browser Ac-
cess section instructions relating to the Web Access function).

PipeIQ offers the ability to check the status of the FAAST device, track events, 
view message logs and look for trends. The user has access to stored and live 
events. Graphs can be generated for the smoke level of the selected FAAST 
detector in real time or over a selected period of time. 

Note: This section describes the Administrator level monitoring functions of 
PipeIQ. To connect PipeIQ to a FAAST device refer to the Connect section of 
this manual. In the Read-Only mode, some operating functions are restricted.

FIGURE 21. PIPE WIZARD PIPE NETWORK SCREEN
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To select the Pipe Diameter being used in the network, select the down arrow   
to the right of the Pipe Diameter field and select the appropriate diameter. If 
Other is chosen, the ID field is enabled and the diameter may be changed by 
highlighting the default value and typing in the value.

To select the proper Sample Hole Size, select the down arrow to the right of 
the Sample Hole Size field and select the appropriate size.

When all settings are correct, select the Next button to move to the next page 
of the wizard, the Detector Screen, as shown in Figure 24.

The Detector Location screen prompts for the location of the detector, either inside or 
outside the protected area and for the height of the detector above the floor.

To select the location of the detector, select the appropriate radio button  
(Inside Room or Outside Room).

When all settings are correct, select the Next button to move to the next page 
of the wizard, the Pipe Network Screen, as shown in Figure 21.



FIGURE 26. REMOTE MONITORING OF USER INTERFACE PANEL

FIGURE 27. MONITORING THE TREND GRAPH

Live View
Select the Monitoring tab in the lower left corner of the window to view a Live 
View of the FAAST system status, as shown in Figure 26. This view shows the 
User Interface panel of the FAAST system. In this mode the screen refreshes 
approximately every 15 seconds. Therefore, there may be a slight delay be-
tween the detector user interface and the Live View in PipeIQ. 

In this view the Test, Reset and Isolate buttons are live and can be used to 
activate the functions on the FAAST detector (as noted this applies only in 
administrative access in the PipeIQ software mode).

Trend Graphs
The system also allows the viewing of trend graphs. Trend graphs represent 
obscuration over time so that the live and stored trends of the system can be 
reviewed to ensure proper operation and find potential problems in the pro-
tected environment.

Select the View Trend Graph link to view the Trend Graph. This opens a split 
screen with the trend graph on the lower portion of the screen, the live view 
on the upper half and trend graph settings on the lower right, as shown in 
Figure 27. 

The trend graph can display either live or stored data. The settings can be 
modified through the interface in the lower right panel. The Date, Trend 
Mode, colors, update rates and other settings can be configured.

FIGURE 28. MONITOR TREND OPTIONS

TREND MODE
Trend mode indicates whether the graph is displaying live or stored data. If a 
live trend is chosen the Date field defaults to the current date. If stored trend 
is chosen then the Date field is required.

Live Trend
To review current events in the system, select Live in the Trend Mode field as 
shown in Figure 28. Choose Start to begin viewing live data. Use the Zoom In 
and Zoom Out controls to fit the data as desired.

Stored Trend
To view historical data, select Stored in the Trend Mode field on the right 
side of the window. Choose Start to begin retrieval of the historical trend data 
stored in the FAAST detector. When retrieval has completed, use the Date field 
and Zoom controls to fit the data on the trend graph as desired.

FIGURE 29. TREND MONITORING SETTINGS
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Date
If the trend graph is operating in Stored mode, then a date must be entered in 
the date field. Use the drop down arrow to display a calendar and select the 
desired date.

Settings
The settings for monitoring trends may be adjusted. Alarm Settings, Threshold 
Scaling, Data Settings and Trend Update Rates are modified from the Settings 
window, as shown in Figure 29. Select the Settings button to open the window. 

The Alarm Settings area of the window displays the alarm levels that can be 
selected to be monitored. Choose the appropriate Alarm Settings by selecting 
the check box next to the Alarm level. To change the color of the Alarm Level, 
click on the color sample next to the level. The custom color palette shown 
in Figure 30 opens. This is where the color of each individual alarm level can 
be selected.

Threshold Scaling can be monitored dynamically which automatically ad-
justs the scale to fit the range or by using a Maximum Obscuration level, 
which allows scale adjustment of the graph. If Maximum Obscuration is cho-
sen, identify the level in the field to the right of the radio button. Select the 
appropriate radio button in the Threshold Scaling area.

The Trend Update Rate can be set in five second increments up to a maximum of 
five minutes. Use the up and down arrows   or enter numbers directly to set the 
number of minutes and seconds to the desired time.



FIGURE 31. LOG VIEW

Live Events
Live Events allows the viewer to see current activities at a specific FAAST de-
vice. The log viewer provides the device ID, a description of the event and the 
time it occurred. The Live Events sections can generate a Report. 

The report can be generated by selecting the Report button, which opens the 
PipeIQ Report Viewer. This screen as, shown in Figure 33, provides calendar fields 
and sort selection buttons. The report itself is first sorted by a start and end date.

To adjust the Start Date, select the down arrow to the right of the Start Date 
field. This opens an interactive calendar, as shown in Figure 32. Select the day 
and month for the start of the report. To set the Hour, Minute, Second and 
AM/PM time for the Start Date, highlight each element and type the required 
time. Follow the same process to create the End Date.

FIGURE 32. INTERACTIVE CALENDAR

Additionally, the report is sorted by Ascending or Descending order by choos-
ing the corresponding radio button. Once the report parameters have been 
determined, select Show to create the report. 

FIGURE 33. PIPEIQ REPORT VIEWER SCREEN

To clear the live event viewer, click the Clear Live Events button.

Stored Events
Stored events can be reviewed by selecting the Stored Events tab at the top 
of the right pane. This shows the events stored in the memory of the FAAST 
device and allows reports to be generated showing past activity. An example 
of a Stored Events report is shown in Figure 34.

Note: The Reset button on the Report Viewer Screen clears the entire Stored 
Events log on the FAAST device.

ASP61-01
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FIGURE 34. STORED EVENTS REPORT EXAMPLE
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Messages
User generated messages can be reviewed by selecting the Messages tab at the 
top of the right pane. This shows any messages (notes) generated by selecting 
the Add Message button. When the Add Message button is selected, a small 
text box opens at the bottom of the Messages area. Any notes may be added 
and stored on the FAAST detector. When the message is complete, select the 
Send Message button to store the message. To clear the messages from the 
device memory, select the Clear Messages button.

SS-400-007 14 E56-3621-003 
  PipeIQ

FIGURE 30. CUSTOM COLOR PALETTE

START
The Start button begins the process of retrieving the data for the trend graph. 
When the button is selected, the label changes to Stop. To stop recording data 
for the trend graph, press the Stop button.

The Plus button gives the option to zoom in on the trend graph to view it in 
greater detail. The Minus button gives the option to zoom out on the trend 
graph and view it over a longer period of time.

CLOSE TREND
The Close Trend link closes the trend graph display displaying only the User 
Interface Panel. 

LOG VIEW
The Log View presents the events that have occurred, such as alarm activa-
tion, fault triggers or password changes. The detector can store up to 18,000 
events. Arrows allow for quick forward or backward movement within the 
event log. To enter the Log View, select the Log View tab located at the lower 
left corner of the bottom pane. There are three tabs, as shown in Figure 31, 
within the Log View: Live Events, Stored Events and Messages. The Live 
Event and Stored Events tabs include a Reports button, which opens the 
PipeIQ Report Viewer. This screen provides calendar fields and sort selection 
buttons for the report. 
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Web Browser Access
COMPREHENSIVE INSTRUCTION MANUAL

SCOPE
This section describes how to access the FAAST detector over a local network 
(LAN) via the Web interface.

The Web interface allows various personnel to monitor the FAAST detector 
from almost any location using a standard web browser. Each of the tabs 
(General, Relays and Thresholds and Network) that are configured using Pi-
peIQ are accessible. In addition, the Live View screen provides status updates 
of the monitored environment as represented by the User Interface Display 
Panel. The Web interface is read-only. Therefore, configuration changes can-
not be made using a browser.

SYSTEM LOGIN
Access to networked FAAST devices may be different for each installation site. 
Typically, each location has its own unique security precautions. To access 
the FAAST detector, first consult with the local site or building manager to 
determine how to gain access to the local network. Once access is obtained, 
the FAAST detector can be monitored by opening a Web browser window 
and typing in the IP address of the FAAST system (the default address is 
192.168.1.10). The Log In screen shown in Figure 1 opens.

Figure 1: Log in screen

Enter the Web Access Password for the FAAST device (the default password is 
1234) and select Submit. It is recommended that the default password be changed 
using PipeIQ during initial FAAST detector setup. The procedure for changing the 
Web Access Password is described in the Network section of this manual.

GENERAL CONFIGURATION SCREEN
When the password is accepted, the General Configuration screen, as shown 
in Figure 2, opens and displays the General tab for the FAAST device.

All of the information displayed on the General Configuration screen is the same 
information that is shown on the General tab when connected via PipeIQ. This 
includes General information about the FAAST system: Device Location, Device 
Date & Time setting and  Button Lock-Out information for the detector.

FIGURE 2. GENERAL CONFIGURATION SCREEN

RELAYS AND THRESHOLDS CONFIGURATION SCREEN
To view the Relays and Thresholds settings for the FAAST detector, select 
the Relays & Thresholds tab. This opens the Relays and Thresholds screen 
as shown in Figure 3, and displays the relays and threshold settings for the 
FAAST system.

All of the information displayed on the Relays & Thresholds screen is the same 
information that is shown on the Relays & Thresholds tab when connected 
via PipeIQ. This includes the Alarm levels chosen, the Acclimate Mode, Night 
Mode and all of the Alarm Thresholds and Delay settings.

FIGURE 3. RELAYS AND THRESHOLDS CONFIGURATION SCREEN

NETWORK CONFIGURATION SCREEN
The Network settings for the device are viewed by selecting the Network tab. 
This opens the Network screen, as shown in Figure 4.

The screen displays the same information as when connected via PipeIQ including 
Device Identification Numbers, Device Connection settings and E-mail Notification  
information.

FIGURE 4. NETWORK CONFIGURATION SCREEN
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LIVE VIEW SCREEN
A live view of the User Interface Display Panel may be obtained by selecting 
the Live View tab, as shown in Figure 5.

The Live View screen automatically refreshes approximately every 10 sec-
onds. To manually refresh more often, select the Live View button again. Any 
changes to the User Interface Display Panel on the actual detector are dis-
played in the Live View screen of the broswer.

NOTE: Browser settings may need to be adjusted to ensure updates are auto-
matically refreshed. (refer to Troubleshooting section)

FIGURE 5. LIVE VIEW SCREEN

FIGURE 6. EVENTS VIEW SCREEN

EVENTS VIEW SCREEN
FAAST detector events may be monitored by selecting the Events tab. This 
opens the Events View screen, as shown in Figure 6. The Events View pro-
vides the user with a complete history of the events for the FAAST device 
being monitored.

The arrows at the bottom of the Event Type list allow the user to move through 
the information one page at a time by using the                         buttons, or to 
move to the first or last page by using the                        buttons.

Log off
To log off and close the connection to the FAAST device, select Log Off in the 
upper right-hand corner of the  screen to end the session.
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Commissioning

COMPREHENSIVE INSTRUCTION MANUAL

Scope
This section provides an overview of the commissioning process for a system 
and describes how the commissioning papers should be completed.

The purpose of the commissioning process is to provide the owner and/or 
building manager with a high level of assurance that the FAAST system has 
been installed in the prescribed manner and is operating within the perfor-
mance guidelines set in the design documents and local codes.

To use this section properly, the commissioning agent should be familiar with 
the FAAST detector, as well as all local codes and regulations necessary to 
commission the system. A typical commissioning process is shown in Table 1.

Commissioning is intended to enhance the quality of system start-up and to 
aid in the orderly transfer of systems for use by the owner or building man-
ager. The commissioning agent is normally a member of the construction 
team that administers and coordinates commissioning activities with the de-
sign team, general contractor, subcontractors, manufacturers and equipment 
suppliers. The commissioning agent provides the owner with an unbiased, 
objective view of the systems’ installation, operation, and performance.

The commissioning process validates all of the required operational functions 
of the FAAST system. It provides benchmarks for all of the individual site set-
tings and generates the documents required for local codes. The documents 
produced by the commissioning process also provide baseline information for 
future maintenance and service of the system.

Step Action

Pre-Commissioning Gather site information; Obtain required 
design records; Obtain pipe network 
installation form; Obtain site plans and 
pipe network as built drawings; Begin 
filling in Commissioning Forms and lo-
cal regulatory forms

On-Site Pre-Commissioning Check cables and Power up detector; 
Verify detector Idle Operation

Configure the System Begin initial configuration; Set detector 
thresholds; Record required information 
on Commissioning Forms

Test System Perform a smoke test on the system; 
Perform pressure tests on sampling 
holes (if required); Verify all Alarm Relay 
functions; Record required information 
on Commissioning Forms

Document Test Results Fill in all required information on 
Commissioning Forms; Forward  
copies of all required forms to the ap-
propriate personnel

Roles of Each Party in the Commissioning Process
Commissioning Agent
The commissioning agent functions as the central contact point to dissemi-
nate information. The commisioning agent assists the design and construction 
teams in completion of the construction process. This includes system veri-
fication, functional performance testing and conformance with the intended 
design of the system. The commissioning agent’s duties include document-
ing construction activities, verifying functional testing and documenting the 
proper performance and operating information to the owner and/or the build-
ing manager.

The commissioning agent verifies that all prevailing local codes and regula-
tions are met or exceeded, along with industry standards.

The commissioning agent also observes and coordinates testing, as required, 
to assure system performance meets the design intent. Results of the commis-
sioning test are documented directly or by appropriate technicians. Another 
responsibility is compiling the commissioning forms to be used, as well as  
ensuring the testing process and the type of information being recorded.

Owner/Building Manager
The owner or building manager assigns maintenance personnel and schedules them 
to participate in any meetings, required training sessions and inspections.

COMMISSIONING PROCESS
Commissioning a system is the final stage of the installation process. It en-
sures that design criteria are met for the pipe network installation and that 
the FAAST system is correctly monitoring the proper alarms and levels for the 
individual installation site.

Pre-Commissioning
Pre-commissioning is a set of tasks that should be performed before visiting 
the actual site. Assemble the following list of documents and necessary items 
before making a site visit.

•	 Obtain the original site layout drawings

•	 Obtain the “as built” drawings from the site

•	 Obtain the pipe network design records

•	 Obtain the pipe network installation records

•	 Obtain a set of the system installation documents

•	 Obtain a set of commissioning forms for the FAAST system

•	 Obtain all required local code forms

•	 Obtain a PC with the PipeIQ software application installed

•	 Obtain all materials to conduct smoke testing on the system

•	 Obtain a digital manometer to measure sample hole pressures  
(if required)

To save time at the site, portions of the commissioning forms may be filled out 
in advance with the customer information and any other information that can 
be completed ahead of the site visit.

ON-SITE PRE-COMMISSIONING
Before beginning the actual commissioning process, check the electrical and 
signal cabling of the FAAST system. Verify that all electrical and signaling 
wiring is correct. Refer to the Installation, Wiring and Cabling Requirements 
sections of the Installation Guide for detailed information on wiring. In addi-
tion to correctness, ensure that all wiring is in compliance with local electrical 
codes and standards.

Verify connection between the PipeIQ application on the PC and the FAAST 
system either through a local network cable or through an internet network 
connection to the system.

Also inspect the pipe network to ensure that it is complete and properly con-
nected to the system before beginning the commissioning process.

Table 1 Commissioning process
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CONFIGURING a New FAAST System
If the FAAST detector has never been configured before, when initially pow-
ered it indicates a configuration fault. Begin the configuration process by per-
forming the following procedure.

1. �If the detector fails to power up, re-check that all power wiring is securely 
and correctly connected.

2. �When the detector is powered, the Configuration fault is illuminated and 
the Urgent Fault relay is set, indicating that the detector has never been 
configured.

3. Open the PipeIQ application.
4. �Create a project using an appropriate title, as shown in Figure 1, by select-

ing File>New from the menu in the upper left corner of the window, or by 
selecting the icon for a new project.

5. �The PipeIQ window on the PC shows the opening pop-up screen, as shown 
in Figure 2 after a new project is created.

6. Select either US Customary System or Metric and select OK.
7. Check that the acknowledgment box on the disclamer.
8. �Double click on the project name to open the project window in the right 

pane, as shown in Figure 3.

9. �Fill in the Name, Installer, Pipe Type and Address information on the form. 
The name shown is the name of the project. The name is automatically 
created using the project name when it is created. You may change it, if 
desired. Enter the name of the system installer in the Installer field. Enter 
the pipe type in the Pipe Type field. The type of pipe is the type used in 
the pipe network (pvc, copper, etc.) Enter the address information for the 
project into the address field.

10. �Connect PipeIQ to the detector by selecting the device in the left pane, 
right-clicking and selecting “Connect Device.” This opens the Connect 
Screen, shown in Figure 4. The text box should contain the default Host IP 
address of 192.168.1.10. Choose Administrator from the drop-down menu 
in the User field and type in the password for the detector. The default 
password is “password.” Select the Connect button and confirm that the 
icon changes to green, showing that the device is connected. This step 
could also be performed at a later time when the data is ready to be trans-
ferred to the FAAST device.

11. �Double-click on the Device icon in the left pane to open the Configuration 
window in the right pane. Fill in the appropriate General information, as 
shown in Figure 5. Be sure that all of the information selected and entered 
is in accordance with local codes and regulations. Tables 2 through 6 ex-
plain the information contained in the fields of the General tab.

figure 1. New Project screen

figure 2. opening pop-up screen

figure 3. new project screen

figure 4. connect screen

figure 5. general configuration tab
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Table 2. General field descriptions

Table 6. alarm/FAULT RELAY LATCHING check box descriptions

Table 3. device date and time field descriptions

Table 4. Button Lock-Out check box descriptions

Table 5. Button Activation field descriptions

Field Description

Facility Name Enter the name of the facility where the  
device is installed

Facility Location Enter the address of the facility

Device Location Enter the area or location in the facility where the 
system is located

Contact Person Enter the name of the person responsible for oper-
ating and maintaining the system

check box Description

Alert Selecting this box latches the Alert alarm

Action 1 Selecting this box latches the Action 1 alarm

Action 2 Selecting this box latches the Action 2 alarm

Fire 1 Selecting this box latches the Fire 1 alarm

Fire 2 Selecting this box latches the Fire 2 alarm

Minor Selecting this box latches the Minor fault

12. �When the information on this screen is complete, select the Apply button 
to make the changes. PipeIQ will inquire if you wish to send the changes 
to the device. If this is not desired, select No and select the save icon to 
save the changes.

13. �Select the Relays and Thresholds tab at the top of the window and select 
the appropriate relay and threshold settings for the system as referenced in 
Table 7. Next, select the Acclimate mode or the start and end times for the 
Day, Night and Weekend modes, if desired, as shown in Figure 6.

Be sure that all of the information selected and entered is in accordance with 
local codes and regulations.

The Acclimate Mode area of the screen allows the user to enable or disable the 
Acclimate feature. This feature automatically adjusts alarm levels within user 
specified parameters to reduce nuisance alarms.

Acclimate mode allows the system to automatically adjust the alarm points 
between the specified minimum and maximum sensitivities that are selected 
by the user. The user chooses the boundaries for each alarm level and the 
system starts as close to the upper boundary of the alarm setting as it can, 
based on the local environment. The system monitors the environment for 
the first 24 hours of operation and then adjusts the alarm level based on the 
readings over that initial 24-hour period. By allowing the system to operate 
in Acclimate mode, the system’s susceptibility to nuisance alarms is reduced. 
This provides maximum protection for an area that may have a varying or 
higher than normal background level.

After the initial 24-hour period, the system adjusts the alarm point based on 
the particulate level over a 1 hour period. The sensitivity of the system contin-
ues to slowly and continuously adjust over time, increasing and decreasing as 
the local environment changes.

The user can select the boundaries for each alarm level. It is also possible 
to have a static alarm level by adjusting the high and low boundaries for an 
alarm to the same level. This allows the flexibility to have acclimate levels for 
some alarms and static levels for others. Table 8 shows the various levels that 
are available.

In Acclimate mode, the Day, Night and Weekend settings are disabled and the 
minimum and maximum threshold levels are enabled to control the alarms. 
The start and end times for the system to enter night mode does not apply 
when the system is running in Acclimate mode. 

If the Disable setting is selected under Acclimate Mode, then the Day/Night/
Weekend settings must be completed in the Threshold Levels section. Values can 
be entered for each alarm level with a respective delay in seconds. Refer to the 
FAAST Maintenance and Instruction Manual for approved settings and ranges.

Field Description

Device Date Allows the user to set the system clock to the cur-
rent date. Select the arrow to the right of the date. 
A calendar appears allowing the user to choose 
the correct month, date and year

Device Time Allows the user to set the system clock to the 
current time. Highlight the hour and click on the 
up or down arrows to set the hour. Repeat for the 
minute, second and AM/PM settings

check box Description

Button Lock-Out The Test, Reset and Isolate button settings allow 
the user to activate or de-activate the Test, Reset 
or Isolate buttons on the user interface

field Description

Passcode Enter the 4-digit code to used to unlock the Test, 
Reset and Disable buttons on the user interface

Confirm Passcode Enter the same 4-digit code again to confirm it

figure 6. relays and threshold configuration tab
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alarm 
level

threshold 
high  

sensitivity

threshold 
low  

sensitivity

current Level

Alert Alert High Alert Low Acclimate Alert Level

Action 1 Action 1 High Action 1 Low Acclimate Action 1 
Level

Action 2 Action 2 High Action 2 Low Acclimate Action 2 
Level

Fire 1 Fire 1 High Fire 1 Low Acclimate Fire 1 Level

Fire 2 Fire 2 High Fire 2 Low Acclimate Fire 2 Level

Table 7. ALARM LEVEL BOUNDARY DESCRIPTIONS

When creating a new project, the Alarm Delay and Threshold fields contain 
default values. These settings may be modified to meet local codes and regula-
tions. To modify these settings, select the field, highlight the value shown and 
enter the desired value.

The Alarm Delay fields are set to a default value of zero. To modify this value, 
highlight the value and enter the desired value.

In normal operation, the Night mode allows separate start and end times, 
which can be set for day, night and weekend operation. To set the Night mode, 
highlight the hour and click on the up or down arrows to set the hour. Repeat 
for the minute, second and AM/PM settings for both the start and end times.

14. �When the information on this screen is complete, select the save icon to 
save the changes.

15. �Select the Network tab at the top of the window and complete the neces-
sary information for the system, as shown in Figure 7. Be sure that all of 
the information selected and entered is in accordance with local codes and 
regulations.

The Device Details area contains the serial number of the detector and an 
identification number (1 – 255). The user may choose any identification num-
ber within the number range. The serial number is assigned at the factory and 
cannot be changed.

For more information see the networking white paper at systemseensor.com/faast.

Tables 9 through 11 provide descriptions of the password and E-mail accounts. 
Note that the password character strings are case sensitive. Passwords may be 
changed in any of the password fields by typing and confirming a password 
once Administrative access has been acquired.

Table 8. Web access password field descriptions

Table 9. administrator password field descriptions

Table 10. Device E-Mail Server Configuration Field  
Descriptions

field Description

Passcode User can input up to a 16-character string

Confirm Passcode User must enter the same character string again to 
confirm it

field Description

Passcode Administrator can input up to an 8-character string

Confirm Passcode User must enter the same character string again to 
confirm it

field Description

Sender Account E-mail address from which the device  
messages originate

SMTP Server Name Determine the SMTP server being used and type the 
SMTP server name in the field. Contact system admin-
istrator if necessary

The Device Connection area allows the user to choose either DHCP or static IP 
addresses for device communication. Choosing the DHCP button deactivates 
the IP settings. If a static IP address is selected, enter the IP Address, Subnet 
Mask and the Default Gateway fields with the proper information (contact 
system administrator if necessary).  Primary and Secondary DNS Server ad-
dresses are required if address resolution of the SMTP server is desired.

The E-mail Notification area allows the user to type in up to six E-mail ad-
dresses. These addresses are notified when an the selected event is triggered. 
The alarm levels reported to each E-mail address can be chosen by selecting 
the appropriate alarm level checkboxes for each address.

16. �When the information on this screen is complete, a dialog box appears 
asking to transfer the configuration changes to the FAAST device. Select 
Yes to begin the download.

17. �When the download is complete, the detector automatically resets and 
begins to take baseline measurements. At this time the system should be 
allowed to run undisturbed for at least five minutes to ensure it calculates 
valid air flow and filter monitoring baselines. When the system stabilizes, 
the front panel indicators are illuminated, as shown in Figure 8. The par-
ticulate level indicators illuminate along with the Test, Reset and Isolate 
buttons. The indicators at the bottom of the display indicate the air flow 
through the detector. If the system has normal air flow, these indicators 
are illuminated in green, near the center of the display.

18. �If the location contains more than one FAAST system, repeat this proce-
dure for each system being commissioned at the location.

Re-Configuring or Updating a FAAST System
When a FAAST detector is configured, certain pipe network specific param-
eters are erased.  During the subsequent power-up, the detector will initial-
ize these parameters for the attached pipe network.  Once the parameters 
are initialized, the detector will operate using these parameters until the next 
configuration change.  Therefore, it is imperative that the pipe network be 
inspected each time the detector is reconfigured. Perform the following proce-
dure to properly re-commission or update a system.

1. �If the system fails to power up and stabilize, re-check that all power wiring 
is securely and correctly connected.

2. �Apply power to the system and open the PipeIQ application. Make sure that 
the PipeIQ application is connected to the detector either through a local 
network cable or through an internet network connection to the system.

figure 7. network configuration tab
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Figure 8. typical stabilized front panel indicators

3. �Create a project using an appropriate title, as shown in Figure 9, by select-
ing File>New from the menu in the upper left corner of the window, or 
by selecting the icon for a new project. To retain information from a previ-
ous project, open the project file associated with the system by selecting 
File>Open and then choosing the appropriate project name.

4. �Connect to the system by right clicking on the device in the left pane and 
selecting “Connect Device.” For an existing device, the text box should have 
the Host IP address that was assigned to that device when it was originally 
configured. Select Administrator from the drop down menu in the User text 
box and enter the password for that device in the Password text box. Select 
the Connect button and the icon should change from a red X to a green con-
nect icon showing the device made a successful connection.

5. �Double click on the Device icon in the left pane to open the Configuration 
window in the right pane. Fill in the appropriate General information, as 
shown in Figure 6. Be sure that all of the information selected and entered 
is in accordance with local codes and regulations.

Refer to tables 2 through 7 that explain the information contained in the fields 
of the General tab.

6. �Continue by doing the same steps described in the Commissioning a New 
FAAST System, starting with Step 11 of the Commissioning Section

figure 9. new project screen

Table 11. Approved Simulated Smoke PRODUCTS

Table 12. Canned Smoke Test

Manufacturer Model

Home Safeguard Industries 25S

SDi CHEK02 and CHEK06

SDi SOLOA4

SDi SMOKESABRE-01

Step Action Verification

1 Make sure that the local fire 
panel and any automatic extin-
guishing or suppressant sys-
tems are either disconnected or 
isolated from external reporting 
equipment

2 Establish that the system is 
working normally

Observe the user interface

3 Release simulated smoke 
(Home Safeguard Industries 
Model 25S or equivalent) near 
the sampling hole at the fur-
thest point from the FAAST unit. 
Release simulated smoke for 
a period of 2 seconds within a 
distance of 6 inches directly at 
the sampling hole. 

Use a stopwatch to measure 
the elapsed time between the 
release of the simulated smoke 
and the first indication of an in-
crease in the particulate level as 
indicated on the Particulate Level 
display. Record the time on the 
Commissioning Form

4 Verify that the alarm re-
lays activate when the alarm  
indicators illuminate

Observe the user interface

5 Make sure to re-connect the lo-
cal fire panel and any automatic 
extinguishing or suppressant sys-
tems after successful completion 
of the test

TEST system

All FAAST systems must be tested after installation and periodically thereafter. 
Testing methods must statisfy the authority having jurisdiction. Systems of-
fer maximum performance when tested and maintained in compliance with 
NFPA 72.

Preparation for Testing
Prior to any test of a building’s fire alarm system, all occupants should be 
notified, in accordance with NFPA 72. This ensures that everyone is aware of 
what is going on and the testing can be conducted efficiently. Typically, a team 
of two performs testing of a FAAST system, with one technician remaining at 
the detector to verify test results, while the other technician introduces the 
canned smoke into the farthest sensing hole of the system.

Before these tests are carried out, ensure that the room or area being protected 
is in its operational state in terms of airflow, temperature and cleanliness. 
Any air handling units should be running, all floor and ceiling tiles should be 
installed and any equipment producing a heat load should be in its normal 
operating mode.

For proper testing, one of the simulated smoke products listed in Table 12 
must be used. A canned smoke test procedure is indicated in Table 13.

System Pressure Testing
Pressure testing should be performed on as many sample holes as possible 
during the initial commissioning tests. This establishes a good baseline to use 
at a later date. During maintenance testing, only a few holes need to be tested 
if they continue to be close to the initial results.

During normal system maintenance, verify the current pressures versus the 
original pressures for the same sample holes. Any significant differences 
should be immediately investigated to determine the cause and potential re-
pair of the system.

ASP-34
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Relay Function Testing
The Relay function can be verified by setting the system into Test mode. The 
Test mode is initiated through the PipeIQ Live View or by depressing the TEST 
button on the user display when the button is enabled. The Test mode simu-
lates a fire condition by activating all ten segments in the Particulate Level dis-
play and each segment in the Alarm display. Each corresponding alarm relay 
is also activated after any programmed delay associated with that relay. Acti-
vation of the RESET button removes the system from Test and resets the relays.

Documenting Test Results
All test results must be recorded in accordance with local codes and regula-
tions. There is a Commissioning Form attached to this document to aid in 
documenting these tests.

Customer Acceptance
Both the team doing the testing and the customer/owner representative 
should be completely satisfied with all the results from the commissioning 
tests. They should also agree that all testing results meet the local codes and 
regulations for the type of system being tested. The final acceptance of the 
system should be a completed with a  signed copy of the Commissioning Form 
and any other relevant documentation required.
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Customer Name:

Project Name:

Site Address:

Installer Name/Contact information: Date:

Commissioning Agent/Contact information: Date:

Client Representative/Contact information: Date:

Witness/Contact information: Date:

Wiring Checked: Date: Yes / No

Detector Settings Checked: Date: Yes / No

Test Relays: Date: Yes / No

Required Documents

Copy of Commissioning Form Yes / No

FAAST system Bill of Material Yes / No

Commissioning Form for each system Yes / No

Smoke Test results (optional) Yes / No

Locally required forms Yes / No

Customer’s Signature: Date:

Commissioning Agent Signature: Date:

FAAST System Validation Form
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Threshold Time Delay Transport times

Day Alert: Predicted: Actual:

Action 1: Predicted: Actual:

Action 2: Predicted: Actual:

Fire 1: Predicted: Actual:

Fire 2:

Night Alert: Alarm Outputs Verified: Yes / No

Action 1: Fault Outputs Verified: Yes / No

Action 2: Isolate Function Verified: Yes / No

Fire 1:

Fire 2:

Weekend Alert:

Action 1:

Action 2:

Fire 1:

Fire 2:

Acclimate Alert:

Action 1:

Action 2:

Fire 1:

Fire 2:

Air Flow Fault 
Thresholds

Low:

High:

Air Handling Yes / No Duct Sampling Yes / No

Number of Sample points: Number of Cabinets:

Conditions:

Temperature:

Humidity:

Other:

As-Built Installation  
Drawings Available? Yes / No

Is the system installed in  
accordance with the design? Yes / No

Is the power supply  
installed properly?

Yes / No
Is the pipe network installed  
and labeled properly?

Yes / No

Describe any Variations:

Sensitivity: % Obscuration/ft.:

Detector Address: Detector Address:

FAAST System Validation Form (CONT.)

Comments:



 Maintenance and Troubleshooting

COMPREHENSIVE INSTRUCTION MANUAL

SCOPE
This section provides guidance through maintenance and troubleshooting for 
the FAAST detector.

FIELD MAINTENANCE
Maintenance of the FAAST detector is quick and easy. The only field main-
tenance recommended is changing the replaceable filter. The filter is located 
behind the Display Door under the User Interface Card, as shown in Figure 1. 

FIGURE 1. �FRONT VIEW OF DETECTOR WITH DISPLAY DOOR OPEN 
AND USER INTERFACE CARD IN PLACE:

FILTER ASSEMBLY REPLACEMENT
Over a period of time the filter collects environmental dust and dirt that even-
tually inhibits proper air flow through the detector. If blockage is detected by 
the detector, a minor filter fault is activated. If the filter is not replaced within 
72 hours, an urgent filter fault is activated.

To replace the filter perform the procedure in Table 1. 

TABLE 1. FILTER REPLACEMENT PROCEDURE

STEP ACTION

1 Before performing maintenance, notify the proper authorities that the 
system is undergoing maintenance, and will temporarily be out of ser-
vice. Disable the system to prevent unwanted alarms.

2 Turn off the system by removing the 24 Volt power connector from the unit 
or by unplugging the converter from its power outlet.

NOTE: If power is not removed, the unit automatically enters Service 
Mode when the screws are removed from the filter. This removes 
power from the fan and the sensing chamber. In addition, the filter 
fault indicator is illuminated and the urgent relay is set.

3 Open the Display Door, as shown in Figure 1, and remove the User 
Interface card in front of the filter.

4 Remove the two Philips head screws securing the filter to the unit, 
as shown in Figure 3.

5 Replace the entire filter assembly, as shown in Figure 2, with a new 
unit by pulling the old filter out and sliding a new filter assembly 
back into position. 

6 Reinsert the two Philips head screws and tighten.

7 Carefully reinstall the User Interface card.

FIGURE 2. REMOVABLE AIR FILTER ASSEMBLY:

FIGURE 3. FILTER MOUNTING SCREWS WITH LANGUAGE CARD REMOVED:

RECOMMENDED STOCK LEVEL
Filters should be kept on site so that they may be changed either on a regular 
schedule, or as needed. This keeps system down time to a minimum. Filters 
have an average life expectancy of 4 years. 

TROUBLESHOOTING GUIDE
This section is intended for additional troubleshooting guidance. For general fault 
conditions, wiring and start up guidelines, refer to the Installation and Mainte-
nance Instructions. Table 2 gives recommended action to possible conditions.

USER INTERFACE CARD

ASP-82

ASP-90
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TYPE CONDITION RECOMMENDED ACTION

Fault Warning External Monitor Fault signals, but nothing is con-
nected to the external monitor relay.

Attach the 47 K-Ohm resistor, included with FAAST detector, to the External Monitor 
terminal when the external monitor function is not being used.

Fault Warning Flow fault signals after power initialization. Check for broken pipe connections or blocked sample holes. Repair any damage to 
the pipe network.  

Fault Warning Flow fault signals after power initialization. If the FAAST system pipe network has changed or the FAAST detector was moved 
to another pipe network, the detector must be re-configured to reset its reference 
baseline.

Fault Warning Filter fault signals after power initialization. If the FAAST system pipe network has changed or the FAAST detector was moved 
to another pipe network, the detector must be re-configured to reset its reference 
baseline. If changes have not been made to the pipe network, replace the filter.

Pipe Network Transport time is significantly longer than the PipeIQ 
design indicates.

Set ALERT and ACTION 1 delay to zero.

Pipe Network Transport time is significantly longer than the PipeIQ 
design indicates.

Be certain that caps are installed in the two ports not being used.

Pipe Network Transport time is significantly longer than the PipeIQ 
design indicates.

Check pipe integrity. Use electrical tape to close all sample holes and check the 
pipe for leaks. This can be accomplished by applying 2 psi of compressed air and 
measuring with a pressure gauge.  The gauge should not drop more than 1 psi in 
15 sec. 

Pipe Network The pipe network prevents the FAAST device from be-
ing removed from the mounting bracket.

Loosen pipe mounting brackets enough to allow the pipe to bend and remove the 
pipe from the top of the detector.

Pipe Network The pipe network prevents the FAAST device from be-
ing removed from the mounting bracket.

Cut a ½ inch (13 mm)section of pipe approximately 6 inches (15 cm)above the 
detector. Remove the detector and steel plate from the wall. Fit a 5/8 (16 mm)inch 
spacer behind the steel mounting plate. Permanently connect a union at the loca-
tion where the ½ inch (13 mm) section of pipe was removed.  The spacer behind 
the back plate will allow the larger diameter union to clear the wall.

PipeIQ The web server isn't refreshing every 10 seconds. If using the Internet Explorer® internet browser, go to Tools and select Internet 
Options.  On the General tab under Temporary Internet Files select Settings.  Set the 
Check for newer versions of stored pages option to Every visit to the page and click 
OK.

PipeIQ Unable to connect to the device. Verify the TCP/IP settings of your network adapter (refer to section PipeIQ FAAST 
Connection Troubleshooting for details). Ensure the IP address used to connect 
matches the IP address of the FAAST device. The IP address of the device can be 
determined by using the IP address blink mode.

PipeIQ Pipes and fittings do not connect on the design page 
of PipeIQ.

There are two things to be aware of prior to specifying the next component in the 
design. First, orient the view to either FRONT, TOP or RIGHT view. Second, high-
light the component to be connected such that it shows yellow. Then, add the new 
component. Always use one of the three views to move the new component on the 
screen.

PipeIQ Cannot edit pipe. Try using one of the three views (FRONT, TOP or RIGHT) to edit.

PipeIQ Cannot disconnect element. Only components with a single connection can be disconnected. In order to discon-
nect a component from within an assembly, all later components must be discon-
nected first. 

Note: Making all component moves/disconnect from a single view will make these 
components easier to reassemble.

User Interface Front panel buttons do not work. Buttons may be configured as locked. Follow procedure to unlock buttons or config-
ure them in the unlock mode.

TABLE 2. TROUBLESHOOTING QUICK GUIDE
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PipeIQ FAAST Connection Troubleshooting 
In order to connect to a FAAST device at its default IP address (192.168.1.10) 
the PC network adapter must be configured to operate in the correct address 
range.  Below are the steps required to make a direct connection to a FAAST 
device.

Take note of current adapter settings.  They will be needed if you wish to re-
store your existing network connection later.  To configure a direct connection 
to a FAAST device choose:

•	 Use the following IP address

•	 IP address: 192.168.1.15

•	 Subnet mask: 255.255.255.0

Select OK to close the dialog box. Select OK again to close the Connection 
Properties window and apply the changes.

Type ping 192.168.1.10 and select OK. The ping application will attempt to 
make contact with the FAAST device 4 times. The first or second request may 
time out, but if a reply is received your network adapter is configured cor-
rectly. If a reply is not received check the Ethernet cable. Also verify that the 
correct network adapter was configured and that it has the correct TCP/IP set-
tings described above. For more information see the networking white paper 
at systemseensor.com/faast.

Windows XP

Go to Start->Control Panel

Open Network Connections

Choose the Wired Network Adapter that will be used to 
connect to the device.  

Right-click and select Properties. 

Choose Internet Protocol (TCP/IP) and select Properties

Choose Start->Run

Type cmd and choose OK to open a command prompt window

ASP-67

ASP-66

ASP-68

ASP-69

ASP-70

ASP-71

ASP-74

ASP-72

ASP-73

Checking Connectivity
To verify that your network settings are correct and you can communicate 
with the FAAST device perform the following:
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 Parts and Accessories

COMPREHENSIVE INSTRUCTION MANUAL

SCOPE
This section provides information on the parts and accessories available for 
the FAAST system. 

Note: Not all parts and accessories are available in all markets.
PARTS AND ACCESSORIES
Table 1 lists additional Parts and Accessories available for use with the  
FAAST detector.

TABLE 1. PARTS AND ACCESSORIES

TABLE 2. PIPE NETWORK PARTS AND ACCESSORIES

Part No. Item Description

CMKT00100 FAAST Binder Provides key documents for 
the FAAST system includ-
ing the Comprehensive 
Instruction Manual.

I56-3620 Installation and 
Maintenance Instructions

Describes the installation, 
features and basic operation 
of the FAAST detector.

F-A3384-000 Air Filter Disposable detector filter.

PIPE NETWORK COMPONENTS
TABLE 2 shows a list of the pipe fittings and accessories available for constructing 
a pipe network for the FAAST detector.  

Part No. Item Image Description

P-PIPE-210 CPVC Pipe  15 ft. lengths, 3/4" Orange 
CPVC pipe, 14 pieces, 210 

ft. Total Length

P-ELB-90 90 degree 
Elbow

 90 degree CPVC Elbow, 
3/4", Socket to Socket, 

qty. 20

P-ELB-45 45 degree 
Elbow

 45 degree CPVC Elbow, 
3/4", Socket to Socket, 

qty. 10

P-TEE Tee  90 degree CPVC Tee, 3/4", 
Socket to Socket, qty. 15

P-COUPLING Coupling  CPVC Coupling, 3/4", 
Socket to Socket, qty. 15

P-UNION Union  CPVC Socket Union, 3/4", 
qty. 10

P-ENDCAP End Cap  CPVC End Cap, 3/4", qty. 
25

P-LABEL-P Sampling 
Point Labels

Sampling Point Labels, roll 
of 100

P-LABEL-T Pipe Label Pipe Labels, roll of 100

P-SAMP-KT Sampling 
Point Kit

Sampling Points with 
Capillary Tubing, qty. 10

Note: Pipe and Fittings are listed to UL 1887.

LANGUAGE CARDS
In addition to the standard English User Interface card, there are other lan-
guages available for use with the FAAST detector.

Table 3 lists the part numbers for ordering User Interface Cards and the lan-
guages that are available.

TABLE 3. AVAILABLE LANGUAGES FOR USER INTERFACE CARD

Part No. Language

F-LCARD-EN Language Card – English

F-LCARD-SP Language Card – Spanish

The User Interface Card can be easily replaced. To remove and replace the User 
Interface card, follow the procedure outlined in Table 4.

TABLE 4. USER INTERFACE DISPLAY CARD REPLACEMENT

Step Procedure

1 Grasp the top of the card and gently lift the center of the card.

2 Carefully remove the card from the 6 mounting tabs, as shown in 
FIGURE 1, from bottom to top.

3 When the card is removed from all of the tabs, remove the bottom 
of the card from the pocket.

4 Install a new card by sliding the card into the pocket. Moving from 
bottom to top, insert the card under each tab. If necessary, use a 
flathead screwdriver to gently press the card in place beneath each 
of the mounting tabs. The card is moderately flexible to allow for 
some bending during installation.

FIGURE 1. USER INTERFACE CARD MOUNTING

MOUNTING
TABS

MOUNTING
TABS

POCKET

ASP-65
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 The Pipe System

COMPREHENSIVE INSTRUCTION MANUAL

SCOPE
This section provides details on the physical installation of the pipe network 
for the FAAST system. Knowledge of local codes and regulations is required in 
addition to this manual.

INSTALLATION STAGES
Table 1 lists the standard installation stages for an aspiration pipe network. 

TABLE 1. TYPICAL PIPE NETWORK INSTALLATION PROCEDURE

STEP ACTION

1 Verify design documents are accurate and obtain the size and 
configuration of the pipes in the network. 

Note: If PipeIQ was used to design the network, a bill of materials 
can be generated from the application.

2 Mark off the area where the system is to be installed and identify 
the location where the FAAST detector is to be mounted.

3 Select and mark the locations for the pipe clips in accordance with 
the design.

4 Install the FAAST detector in its permanent location. (See 
Installation and Maintenance Guide for details.)

5 Mount the pipe clips according to the previous markings.

6 Dry mount and assemble the pipe network according to the pipe 
network design documents. 

CAUTION: Do not permanently connect the pipes at this time.

7 Measure and mark the sampling holes on the pipe network. Make 
sure that the spacing of the sampling holes is in accordance with 
the network design. Based upon the application, ensure that the 
sampling holes are at the correct orientation to the air flow, as rec-
ommended in the section on network pipe design.

8 Verify the sampling-hole positions and orientations and drill the 
sampling holes.

9 Drill and install end caps on all appropriate pipe ends.

10 Modify the design documents to agree with the actual network, 
if the physical network is significantly different from the original 
design documents.

11 When testing is complete and the system performance is verified, 
permanently bond the pipe network together. 

CAUTION: Never bond the pipes to the detector. The detector 
inlet and outlet are tapered to accept the piping without any bond-
ing and provide an air tight seal.

12 Label all portions of the system according to local codes and regu-
lations. Pipe and Sampling Point labels are available –  
refer to the Accessories section.

13 If additional changes are made, ensure that design documents 
are updated accordingly.

PIPE NETWORK COMPONENTS
The FAAST detector uses standard aspiration fire detection pipe network com-
ponents, such as pipes, elbows and couplings. The components listed in this 
section are not an all inclusive list of components used for fire protection sys-
tems. However, they represent the most commonly used items.

PIPES
The pipes used in the pipe network can be made of various materials includ-
ing copper, PVC, ABS, UPVC and CPVC. The internal pipe diameter used with 
the FAAST system can range from 0.591 to 0.827 in. (15 to 21 mm). Ideal 
dimensions vary depending on system design requirements, as well as local 
codes and regulations. The FAAST detector has a built in tiered insertion point 
for the pipes, which allows for an outside tube diameter of either 1.050 in. or 
25 mm to accommodate U.S. Customary System and Metric System sized pipe.

FITTINGS
Fittings are used to connect sections of pipe together on longer network runs 
and are made from the same material as the pipe. There are several types of 
fittings to allow for various bends, straight runs, branches and connections. 
Common fittings are described in the following sections.

Couplings and Unions
Couplings and unions are used to connect two sections of pipe in a straight 
line. A coupling is used when the section is not intended to be taken apart. 

A union offers the ability to screw the two pipe sections together for future 
access, such as areas of the pipe network that have to be periodically dis-
assembled for maintenance or cleaning. Unions can also be used to orient 
sample holes correctly in a specific section of the pipe network, such as over 
return air grilles. Figure 1 shows a typical union and coupling.

FIGURE 1. TYPICAL UNION AND PIPE REDUCER

FIGURE 2. 45 AND 90 DEGREE ELBOWS

45° 90°

FIGURE 3. TEE

FIGURE 4. end cap

ASP-76

ASP-77

ASP-80

ASP-79

ASP-75

ASP-78

Elbows
Elbows are used to change the direction of the pipe network. Both 45 degree and 
90 degree elbows may be used. Both elbow fittings are shown in Figure 2.

Tees
Tees are used for attaching drop tubes or sampling pipes in the network.  
A specialized tee can be used to attach a capillary tube and a sampling point. 
A tee is shown in Figure 3.

End Caps
The end of the pipe should be terminated with an end cap. The end cap may 
have a sampling hole depending upon the system design. The size of the hole 
in the end cap is determined by the PipeIQ software. An end cap is shown in 
Figure 4. 
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CAPILLARY TUBES AND SAMPLING POINTS
A capillary tube is a length of flexible tubing that is connected to the main 
sampling pipe with a sampling point at the end. The purpose of these tubes 
is to extend the placement of the area being sampled away from the main 
pipe network. This may be necessary to reach into an enclosed space, such 
as a cabinet, or for aesthetic and security reasons. This allows  the core pipe 
network to be hidden, while only a small sampling point is located in the 
main space. Figure 5 shows the capillary tube extending down from the main 
sampling pipe with a sampling point on the end. The sampling hole is located 
in the sampling point. PipeIQ allows for capillary tubes and sampling points 
to be added to the pipe network design and will calculate the appropriate air 
flow through the system.

The maximum length for capillary flexible tubing is 26 ft. (8 m). When mul-
tiple capillary tubes are used in a network, the length of each capillary tube 
should be approximately equal. A sampling hole is required at the end of each 
capillary tube. PipeIQ will provide direction when designing capillary tubes 
into the pipe network.

figure 5: capillary tubes with sampling points

FIGURE 6. TYPICAL PIPE MOUNTING BRACKETS

Mounting Brackets
The pipe network is mounted to the ceiling or other appropriate location us-
ing pipe mounting brackets. A large variety of brackets are available. Typical 
brackets include clips, saddle clamps or tie wraps, as shown in Figure 6. The 
mounting choice will depend upon the material being mounted to, environ-
mental conditions, as well as local codes and regulations. Mounting brackets 
are usually centered 5 ft. (1.5 m) apart when using ¾ inch sch40 pipe at 70°F 
(21°C). Open style mounting clips should not be used in an inverted position 
with the open section facing downward such that the pipe could drop from 
the clip.

Labels
Labels are available to identify the pipe network as a fire detection system, 
both at the sampling points and along the pipe itself. NFPA 72 states that the 
pipe should be labeled:

1.	 At changes in direction or branches of piping
2.	 At each side of penetrations of walls, floors, or other barriers
3.	� At intervals on piping that provide visibility within the space, but no 

greater than 20 ft. (6.1 m)
PIPE NETWORK INSTALLATION
This section provides the basics to installing a pipe network. Keep in mind 
that each system will have different characteristics, and will have variations 
to accommodate. The most common issues are described in the following 
sections.

Cutting Pipe
Proper tools must be used when cutting pipe. Pipe shears or a wheel type 
plastic tubing cutter can be used for PVC or CPVC pipe. Always keep the cut-
ting edge of the tools sharp. Ensure that cuts are made perpendicular to the 
pipe length keeping the cuts square. Square cuts ensure maximum bonding 
area and help provide a good seal when joining the components.

Remove all loose material and any burrs from the end of the pipe after a cut. 
Debris and shavings from cuts must be removed in order to keep sampling 
holes free of obstructions. 

Joining Components
The pipe network must be permanently connected once the system has been 
installed and tested. The method to accomplish a permanent connection de-
pends upon the material of the pipe and fittings.  

NOTE:  The immediate connections between the inlet pipe and exhaust pipe 
and the FAAST detector SHOULD NOT be permanently connected.  

When bonding components together, never place solvent on the inside of a 
pipe or other component. Apply the solvent only to the outside of the pipe 
that is being inserted into a coupling or other component. If solvent is ap-
plied to the inside of a pipe or other component, the solvent can build up. 
This build-up can affect the air flow within the pipe network and may cause 
abnormal behavior within the pipe network.

Make sure that pipes are inserted completely and butted against the lip of the 
coupling or other component. If this is not done, turbulence can be created due to 
the gaps, which can cause problems with system pressures and air flow.

Mounting the Pipe Network
The following recommendations should be taken into consideration when 
mounting the pipe network.

•	 Minimize flexing of the pipes by securing them at proper intervals with 
appropriate mounting brackets.

Maximum support spacing 

Pipe Diameter 60°F 100°F 140°F

½ in. (15mm) 4½ft. (1.3m) 4ft. (1.2m) 2½ft. (0.7m)

¾ in. (20mm) 5ft. (1.5m) 4ft. (1.2m) 2½ft. (0.7m)

•	 Typically, the pipe network should be mounted between one and four 
inches (25 – 100 mm) below the ceiling, subject to local codes and 
regulations.

•	 Allow for expansion and contraction of the pipe network in areas of ex-
treme temperature fluctuations, especially on long straight runs of pipe.

•	 In areas of extreme temperature fluctuations, never place mounting 
brackets adjacent to couplings, unions or tees. This can lead to interfer-
ence with expansion or contraction of the pipe network.

•	 To minimize the effect of pressure differentials, the sampled air should 
be returned to the protected environment wherever possible. This 
eliminates any pressure differentials that might reduce the air flow in 
the pipe network.

ASP-81

ASP-83
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Pipe Bends
Never bend pipes, unless absolutely necessary. Use elbows, tees or other fit-
tings to change the direction of the pipe.

If bending is necessary, determine how much bending the pipe can tolerate 
before beginning the process. Always use bending springs and pipe benders. 
Never heat the pipe or bend it around sharp objects. If a pipe is kinked while 
bending, replace it with a new section of pipe. Conform to all local codes and 
regulations for bending of pipes.

Drilling Sample Holes
Each hole in the sampling pipe represents a smoke detection location. Hole 
placement and size are determined using the PipeIQ software. Sample holes 
should be drilled after the pipe network has been installed. To prevent sam-
pling holes from being blocked by dust and dirt, place the holes on the bottom 
side of the sampling pipes, not on the top of the pipe. This ensures that any 
falling debris does not clog the sampling holes. This hole positioning should 
also be followed for voids in the ceiling or floor.

The following guidelines should be followed when drilling the sample holes 
in the pipe network.

•	 Holes must be drilled perpendicular (90 degrees) to the pipe. If the drill 
is not held perpendicular, the hole is not round and may affect air flow.

•	 Sampling holes must be drilled exactly at the positions marked on the 
pipe with the exact size determined by the PipeIQ software.

•	 Holes must not be drilled through both sides of the pipe.

•	 Holes should be drilled with a slow speed drill with a sharp drill bit. This 
minimizes dust and burrs entering the pipe network.

It is always good practice to blow compressed air through the pipe after drill-
ing to clear any debris before final connection to the FAAST detector. Alter-
nately, a shop vacuum can be used to remove debris from the pipe network.  
Remove the end cap and use the vacuum to draw the debris through the end 
of the pipe near the FAAST system connection. 

DILUTION IN ASPIRATION SYSTEMS
Air from an aspiration system is drawn in from several sampling points along 
the pipe network. Because of this, air from a single point in the system is 
diluted by the combination of air from the entire system. This affects the con-
centration of smoke particles in the air that reaches the detector. The dilu-
tion effect must be accounted for when designing the overall FAAST system. 
PipeIQ automatically calculates the primary factors contributing to the effects 
of dilution on the system.

A general guideline for the effect of dilution on the pipe network is given in 
the following example. A smoke source of 2% obscuration/ft is introduced at 
the far end of a pipe having 10 sampling holes. No other smoke is entering any 
of the other sampling holes. As the smoke passes each hole, the smoke filled 
air is added to with clean air. When the sample reaches the detector it is now 
at 0.2% obscuration/ft. or 1/10th of its starting density. Therefore if the first 
alarm threshold is set at 0.2% obs/ft., the smoke outside the hole must exceed 
2%/ft. to sound the alarm.

The longer the pipe and the greater the number of sampling holes, the more 
susceptible the system will be to dilution. It is better to operate on the conser-
vative side of the situation due to the variable influences on the system.  In ac-
tuality, the calculation of dilution is not as straightforward as above and more 
factors are involved. Each system will have different characteristics, meaning 
precise calculation is complicated. Issues that will affect the dilution rate in-
clude size, location and number of holes, tees, elbows and joints, diameter of 
the pipe itself, as well as, outside elements such as air temperature, pressure 
and humidity.
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 Application and Design

COMPREHENSIVE INSTRUCTION MANUAL

SCOPE
This section is intended to provide general design and application guidelines 
for designing pipe networks in conjunction with the FAAST system. It contains 
relevant design considerations and recommendations on how the FAAST sys-
tem may be installed in various applications. 

DESIGN
There are basic requirements that must be followed for a good site design. The 
more information that is obtained up front, the easier the process will be. The 
following items are provided to aid the design process.

•	 Understand local codes and standards.

•	 Gather all relevant information about the site, including the floor plan 
for the protected space. The floor plan must also include existing or 
proposed fixtures, fittings, air handlers, vents and other equipment that 
requires special consideration.

•	 Determine the uses of the protected area to establish any special requirements.

•	 Verify the protection level required for the area, i.e. standard fire detec-
tion, early warning fire detection, very early warning fire detection.

•	 Use the PipeIQ® software to design the pipe network for the FAAST detector.

Regulatory Requirements
Local codes and regulations can determine the size and spacing between the 
sample holes in a network, making them a critical part to any pipe design. 
These requirements change depending on the type of environment being 
monitored. Local codes and standards take precedence over any parameters 
suggested by this document for the FAAST system.

Site Layout And Measurements
Planning of fire protection zones and relevant FAAST system locations are 
needed to begin the planning process. The plan should include measurements 
of the area to be protected and any areas designated for a different use. The 
plan should also show any obstacles to the free flow of air in the space, i.e. 
partitions or other large objects. Areas requiring special protection should also 
be noted.

Locations of large machinery, equipment, cabinets or any other large items 
that may affect the pipe network design also need to be indentified on the 
plan. The pipe design can be overlaid onto an existing CAD drawing of the site 
plan using the PipeIQ software.

Site Details 
When designing the fire protection system, there are a number of site details 
that need to be taken into account:

•	 Air flow and the location of air handling units, returns, exhaust systems, etc.

•	 Construction of areas being monitored – high ceilings, ceiling and floor voids

•	 Obstructions to the pipe layout – beams, walls, furniture

•	 Placement of equipment requiring any special protection – electrical 
cabinets

•	 Monitoring requirements – on site, remote

•	 Activities within the environment – public space, office space, clean 
room, warehouse, etc.

Environmental Conditions
Identify as many ambient conditions that exist within the protected area of 
the site. Typically different areas have different conditions. This includes in-
formation such as temperature, humidity and altitude. The more accurate the 
information about the protected areas, the better the FAAST system can be 
designed to meet those needs.

The environment, both internally and externally of the protected environment 
(especially if air is being pulled in for heating or cooling), may have an ef-
fect on the operation of the FAAST detector. High pollution levels may cause 
background levels of particulate matter in the protected area. The Acclimate 
feature of the FAAST system helps to compensate for this background level. 
This setting may be chosen during configuration. Or, if the environmental 
changes are better defined by days of the week, the FAAST detector offers a 
day/night/weekend mode.

In locations that are normally subjected to difficult environmental conditions, 
such as loading docks or warehouse spaces, the FAAST detector is typically 
located within a controlled environment, while the pipe network is located in 
the harsh environment.

System Design
PipeIQ is designed to take the information gathered during this initial phase 
and assist in designing the pipe network. There are two design methods 
within the PipeIQ software. One offers a design wizard to create a simple 
layout based on the parameters provided. The other allows for customization 
throughout the process. Both methods provide the opportunity to go back 
and modify the system as needed to accommodate the environment being 
protected. For complete directions on the operation of PipeIQ refer to the sec-
tion titled PipeIQ.

SAMPLING METHODS
There are two general types of sampling methods: standard pipe network 
sampling and capillary tube sampling. From these sampling methods several 
design configurations can be used to meet the needs of a particular site en-
vironment. Local codes and standards along with site requirements will help 
determine the best air sampling method. 

Standard Pipe Network Sampling
The following guidelines are used for any pipe network design. Also, some ad-
ditional guidelines specific to different sampling methods may apply.

1.	� Local codes and standards always take precedence over any values speci-
fied in this documentation.

2.	� Recommended pipe network material is nominal ¾ in. schedule 40 inter-
nal diameter (25 mm OD) CPVC, PVC, ABS or UPVC pipe.

3.	� There should be a minimum of 20 in. (500 mm) of straight pipe at the 
FAAST detector input.

4.	 Sharp bends decrease airflow and performance.
5.	 All pipe designs must have an end cap.
6.	� Multiple shorter pipes provide better performance than a single longer 

length pipe.

7.	� Symmetrical designs both in pipe length and hole size and distribution 
are preferred to optimize FAAST system performance. 

8.	� To prevent sampling holes from being blocked by dust and dirt, place the 
holes on the bottom side of the sampling pipes, not on the top of the pipe. 
This ensures that any falling debris does not clog the sampling holes. 

9.	� To minimize the effect of pressure differentials, the sampled air should 
be returned to the protected space wherever possible. This eliminates 
any pressure differentials that might reduce the air flow in the pipe net-
work.

Capillary Tube Sampling
Capillary tube sampling is a method of locating sampling points remote from 
the main sampling pipe. This is particularly useful where the main sampling 
pipe cannot be routed through the area requiring protection for either techni-
cal or aesthetic reasons. Capillary tubes are also used to sample equipment 
cabinets or enclosures within the protected area. 

In the absence of any other guidance, it is recommended that a minimum 
of two capillary sampling points are sited in a room. This allows a degree of 
redundancy should any one hole become obstructed. PipeIQ will allow sam-
pling points and capillary tubes to be added as part of the design parameters. 
Local codes and standards differ on issues, such as the minimum distance 
detection points that can be positioned from walls and ceilings. It is important 
that the specific local regulatory requirements are observed.

The following guidelines are recommended for capillary tube use.

1.	 Try to keep the length of capillaries the same.
2.	 Capillary tube length should not exceed 26 ft. (8 m).
3.	� When sampling equipment cabinets or other enclosures, the sampling point 

is typically placed at or close to the top of the interior of the enclosure.
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OPEN AREA PROTECTION
Ceiling Sampling
In typical ceiling installations, the pipe network is suspended from 1 in. to 1 
ft. (25 mm to 300 mm) below the ceiling level in the protected area. This type 
of installation is the most common installation. It could be used in offices, 
warehouses, equipment rooms and a variety of other types of installations. 
The pipes and hence the air sampling holes are exposed to the protected envi-
ronment. The PipeIQ software can also provide guidance for the design.

Concealed Pipe Networks
Capillary tubes are typically used for concealed pipe networks. This type of 
network is normally used for either aesthetic or security purposes. The main 
pipe network is installed in a ceiling void and capillary tubes are branched off 
at regular intervals. These capillary tubes are used to monitor the protected 
area by projecting through the ceiling covering while the main pipe network 
remains hidden. 

Inter-Beam Sampling
When large ceiling beams are used in construction, pockets of space are 
created between the beams. In normal circumstances, the pipe network is 
mounted on the bottom of the beams and does not sample the large spaces be-
tween the beams. If it is necessary to cover this space, a rigid pipe in the shape 
of an inverted “L” can be extended vertically from the pipe network up into 
the area between the beams so that the pipe reaches up towards the ceiling in 
these locations. The sampling hole should be drilled just before the end cap 
on the horizontal portion of the pipe. The ends of these sampling pipes should 
be capped with an end cap. The end cap may or may not have a sample hole, 
depending on the pipe network design.

UNDER FLOOR PROTECTION
Floor Void Sampling
The FAAST system is well suited to protect concealed voids, either in the ceil-
ing or under the floor. Some locations use either ceiling and/or under floor 
voids as return air plenums (ducts). To monitor the return air in these areas, a 
pipe network must be designed to monitor the flow through these areas. Some 
ceiling and floor voids are used for cable runs or for small equipment instal-
lation. Monitoring of these areas must be done using a pipe network designed 
for operation in these areas. When installing pipe in a floor void, keep in mind 
that the air sampling holes are still located at the bottom of the pipe. This 
means that the pipe would be located towards the upper portion of the void.

OBJECT PROTECTION
Cabinet Sampling
Equipment cabinet sampling may be accomplished in two ways: pipe net-
works and sampling points can be installed directly inside the equipment cab-
inet or directly over the equipment cabinets being monitored, if the cabinets 
have ventilation grills.

In-Cabinet Sampling
For in-cabinet sampling, capillary tubes can be used to enter the equipment 
cabinet. The capillary tube is connected to the pipe network via a tee connec-
tion with an adapter. The maximum length of these capillary tubes is 26 ft. (8 
m). PipeIQ can help create an appropriate design.

An alternative to capillary tubes is a rigid drop tube. In this application, the 
pipe network is run over a row of cabinets and drop tubes are run down to 
each cabinet. This tube or pipe should be less than or equal to the network 
pipe diameter and is connected to the top of the cabinet and to the pipe net-
work via a tee connection. Or the pipe could come up from under a floor void 
into the cabinet.

Cabinets with extractor fans may cause sampling problems when the sample 
point is on top of the cabinet. The extractor fan creates a low pressure area 
within the cabinet that can stop air from being drawn into the detector system 
at the sampling point. This type of installation must be checked carefully for 
proper sampling operation. This can be accomplished using canned smoke at 
the sample point location.

Above Cabinet Sampling
In above cabinet sampling, the pipe network should be installed directly over 
the cabinets that will be protected. Sampling holes are placed over the cabinet 
ventilation grills. Holes should be oriented so that they face into the air stream 
coming from the cabinet. If there is more than one exhaust from a cabinet, a 
sampling hole should be installed over each opening.

NOTE: With either application it is best to locate the sampling hole in the path 
of the air flow, near the top of the cabinet.

LARGE AREA PROTECTION
Large volume areas and areas with high ceilings require special design con-
siderations for the pipe network design. Stratification occurs when smoke is 
heated by smoldering or burning materials and becomes less dense than the 
surrounding cooler air. The smoke rises until there is no longer a difference in 
temperature between the smoke and the surrounding air. (See NFPA 72-2007, 
A.5.7.1.10.) Stratification, therefore, may occur in areas where air tempera-
ture may be elevated at the ceiling level, especially where there is a lack of 
ventilation. When stratification is likely to occur, conventional pipe network 
sampling may not be effective.

One method to overcome the stratification problem is to create a vertical sam-
pling pipe in addition to the horizontal pipe network on the ceiling. The verti-
cal sampling pipe has sampling holes at various heights to sample within any 
stratification layers present in the area, as shown in Figure 1.

FIGURE 1. VERTICAL SAMPLING PIPE

COLD AREA PROTECTION
The FAAST detector is approved for operating temperatures ranging from 
32°F (0°C) to 100°F (38°C) and sampled air temperatures ranging from -4°F 
(-20°C) to 140°F (60°C). However, special considerations should be taken 
when operating at the extreme end of these ranges, especially the cold end. 
Refer to the section titled The Pipe System for recommendations on handling 
the pipe itself in cold environments. 

The temperature in a cold area is typically just at or above 32°F (0°C). In 
designing a pipe system, the pipes should be kept out of the immediate airflow 
from a chiller unit, if used, as its air is often significantly colder than the room 
itself, in order to maintain the correct temperature. In a cold room application 
it is not usually necessary to use a heater element, but only a water trap to 
remove condensation. For more information see the cold storage white paper 
at systemsensor.com/faast.
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HIGH AIR EXCHANGE AREAS
Typically, high air exchange areas have some form of mechanical ventilation 
to maintain constant or cyclical air flow for heating, cooling or maintaining 
some other sort of special environment. Smoke tends to travel with the air 
flow, so positioning sampling pipes near the return of an air handling unit or 
heating/air conditioning unit ensures early detection of particulate in the area. 
NFPA classifies air exchange area as: medium – 6 air exchanges per hour; high 
– 12 air exchanges per hour.

Normal sampling methods for high air exchange areas are a combination of 
return air and ceiling sampling. The return air sampling provides protection 
when the air flow is present. The ceiling network provides protection when 
the air flow is off. Local codes typically require smaller sample areas (closer 
spacing of sample holes) as the air flow rate increases.

Return Air Sampling
Return air sampling provides an effective means of very early warning in a 
high air velocity environment, such as a mechanical air conditioned area or an 
area equipped with an Air Handling Unit. Placing the pipe network sampling 
holes directly in the air stream at a return air grill allows the system to monitor 
air that has circulated throughout the protected area.

The following guidelines should be reviewed and followed to ensure proper 
sampling by the detector system.

1.	� More than one sampling location may be required for large air grills. 
NFPA 76 recommendations specify that each sampling hole can cover a 
maximum of 4 sq. ft. (0.4 m2).

2.	� Sampling holes should be aligned at an angle of 20 to 45 degrees to the 
direction of the maximum air flow.

3.	 Sampling pipes should be placed in the path of greatest air flow.
4.	 The number of bends in the pipe network should be kept to a minimum.
5.	� Pipe ends should be capped with an end cap. Depending on the pipe 

design and PipeIQ recommendations, the end caps may or may not have 
a sampling hole.

6.	� Socket unions should be used in locations where the pipe network requires 
the removal of the pipes on a regular basis for maintenance purposes.

7.	� Use standoff fittings to keep the pipe network at least 2 to 8 in. (50 to 200 
mm) in front of the grill for high velocity air flow locations. Installing the 
network any closer to the input grill locates the sample point in an area 
of negative air pressure.

8.	� Always keep in mind that the monitored environment should still ensure 
coverage if the manufactured air flow gets disrupted.

Generally, the FAAST detector should not monitor more than one air handler. 
The number of air handlers monitored is limited by the maximum length of 
the pipe network runs. However, the degree of particulate dilution and air 
movement that occurs with multiple air handlers can adversely affect sys-
tem response times. Final system testing should be done to confirm actual 
response times. 

IN-DUCT SAMPLING 
The FAAST detector is approved for in duct applications. National and local 
safety standards and codes recognize the ability of air duct systems to transfer 
smoke, toxic gases, and flame from area to area. Sometimes smoke can be of 
such quantity as to be a serious hazard to life safety unless blowers are shut 
down and dampers are actuated. The primary purpose of duct smoke detec-
tion is to prevent injury, panic, and property damage by reducing the spread 
(recirculation) of smoke. Duct smoke detection also can serve to protect the 
air conditioning system from fire and smoke damage, and can be used to assist 
in equipment protection applications, for example, in the ventilation/ exhaust 
duct work of mainframe computers and tape drives. For additional informa-
tion relating to duct applications refer to the System Sensor website.

Design Considerations for In-Duct Sampling
The following guidelines are necessary to obtain the best installation results.

1.	� Pipes should always be supported at both duct walls – rubber grommets 
can be used. Silicon sealer must also be used to ensure an airtight seal in 
the duct walls.

2.	� Inlet pipes must be inserted between six and ten duct widths or diam-
eters (for round ducts) from any disturbances to the flow generated by 
sharp bends, plenums, nozzles or branch connections, etc.

3.	� Position the sampling hole at either end of the sampling pipe at least 2 
in. (50 mm) from the duct walls.

FIGURE 2. IN-DUCT PIPE ORIENTATION

4.	� Holes on the inlet pipe should face 20-45° into the air flow with the holes 
concentrated at the center of the duct as shown in Figure 2.

5.	� The exhaust pipe must have 4, 3/8 in. (9.5 mm) holes. Holes should be 
concentrated in the middle of the duct’s width and spaced evenly. Holes 
on the exhaust pipe should be oriented such that they face away from the 
air flow.

Small Duct Sampling
For ducts with a width less than 3 ft. (1 m), the inlet pipe should be in-
stalled at the midpoint of the duct height or diameter. Exhaust pipes should 
be inserted 18 in. (0.5 m) downstream from the input pipe. The exhaust pipe 
should be at one quarter of the duct height or diameter, as shown in Figure 
3. To avoid dilution, sampling pipes should be located before fresh air intakes 
and before the exhaust air output.

FIGURE 3. SMALL DUCT SAMPLING PIPE PLACEMENT

TABLE 1. HOLE SIZES FOR SMALL DUCTS

DUCT WIDTH NO. OF 
HOLES

HOLE SIZE NOMINAL PIPE 
FLOW RATE (CFM)

12 in.  
(300 mm)

2 1/4 in.  
(6.5 mm)

1.84 cfm  
(52.0 L/min)

20 in.  
(500 mm)

3 1/4 in.  
(6.5 mm)

1.83 cfm  
(51.9 L/min)

28 in.  
(700 mm)

4 11/64 in. (4.5 
mm)

1.70 cfm  
(48.1 L/min)

36 in.  
(900 mm)

5 5/32 in.  
(4 mm)

1.81 cfm  
(51.2 L/min)

Large Duct Sampling
For ducts with a width of 3 ft. to 7 ft. (1 m to 2 m), two branch pipes are rec-
ommended for the inlets. Inlet pipes should enter a quarter of the way from 
the top and bottom of the duct, as shown in Figure 4.

The exhaust pipe should be inserted approximately 18 inches (0.5 m) from the 
inlet pipes and half way up the height of the duct.

To avoid dilution, sampling pipes should be located before fresh air intakes 
and before the exhaust air output.
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TABLE 2. HOLE SIZES FOR LARGE DUCTS

DUCT WIDTH NO. OF 
HOLES

HOLE SIZE NOMINAL PIPE 
FLOW RATE (CFM)

3 ft. 4 in. (1 m) 6 9/64 in.  
(3.5 mm)

1.77 cfm  
(50.2 L/min)

5 ft. (1.5 m) 8 1/8 in.  
(3 mm)

1.80 cfm  
(50.9 L/min)

6 ft. 6in. (2 m) 10 1/8 in.  
(3 mm)

2.10 cfm  
(59.6 L/min)

The information shown in Table 1 and Table 2 applies to a 15 ft. (4.6 m) inlet 
pipe and a 10 ft. (3 m) exhaust pipe. Always check with local codes and stan-
dards for hole size and spacing.

Hole Orientation
Sampling response time can also be improved by avoiding low and high veloc-
ity air flows. Holes on the inlet pipes should be facing into the airflow. Holes 
on the exhaust pipe should be facing away from the airflow.

MONITORING VOIDS
In these high air exchange environments, detection systems should be in-
stalled in any void, unless the void is completely empty and presents no 
fire risk. If the void contains cabling and/or equipment that can initiate or 
contribute to a fire, monitoring for combustion is highly recommended. The 
sampling-hole spacing for these areas is the same as the requirements for the 
rest of the area, in accordance with the relevant local codes and standards.

When sampling pipes are installed in shallow voids having poor ventilation, 
special care should be taken to position the piping as close to the top of the 
void as possible. This gives the best early warning due to the likelihood of the 
initial smoke layer taking up only the top 10% of the void height.

Local codes and standards normally recommend the area of coverage per sam-
pling hole. Most standards define different pipe and hole spacing, depending 
on certain criteria, such as air exchange rates, etc. Careful adherence should 
be made to relevant local codes and standards. 

For more information see the cold storage white paper at systemsensor.com/faast.

FIGURE 4. LARGE DUCT SAMPLING PIPE PLACEMENT
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